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Acknowledgements

We would like to acknowledge the input and materials from various people and organizations.
Many documents created by the California Department of Mental Health (DMH) were used as
sources and resources for the production of this training.

Due to the Governor’s Proposed Budget for FY 2012-13 to eliminate the Department of Mental
Health (DMH), MHSA programs and functions will be transferred to other departments. It is
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Definitions and Abbreviations

Term
3M
ADL
Adult
BPD
CA-RW
Child/Youth
Csl
Ccsv
DCR
DMH
FSP

FY
HIPAA
IADL
IF
ITWS
KET
MH
MHSA
MHP
Older Adult
PAF
PHI
PLD
Partner
RO
RPR
RW

SB

sQL
SSA
TAY
TOC

Meaning
Quarterly Assessment

Activities of Daily Living

Adults of Ages 26 - 59

Browse Partner Data

County Administrator, Read/Write
Children of Ages 0 - 15

Client Services Information
Comma-Separated Values

Data Collection and Reporting
California Department of Mental Health
Full Service Partnership

Fiscal Year

Health Insurance Portability and Accountability Act

Instrumental Activities of Daily Living
Immediate If Function

Information Technology Web Services
Key Event Tracking

Mental Health

Mental Health Services Act

Mental Health Plan

Older Adults of Ages 60+

Partnership Assessment Form
Protected Health Information
Partner-Level Data

A Client of the Full Service Partnership
Read Only

Run Partner Report

Read/Write

Security Breach

Structured Query Language

State System Administrator
Transitional Age Youth (Ages 16 — 25)
Table of Contents
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Introduction

This training curriculum is designed to be used as a tool for training staff to use the DCR data
extract files to evaluate and analyze FSP data. Trainers can use the PowerPoint presentations
available together with this document’s presenter’s notes to perform employee trainings.
Alternatively, employees can follow this manual’s slide handouts with text narrative for guided
self-instruction to perform the analyses.

This training curriculum covers aspects related to extracting data from the DCR, importing data
into Microsoft Access or Microsoft Excel, and building analyses and reports. A separate training
curriculum addresses using the features of the FSP DCR to submit FSP data.

This training curriculum is intended for any person who utilizes the FSP DCR data extracts. This
training requires users to download the Partner Level Data (PLD) Templates from the
Information Technology Web Services (ITWS) website and is best suited for analysts who have
general knowledge of Microsoft Excel, Microsoft Access and the formulas used by these
applications. An outline of the training curriculum appears below.

» FSP Data Analysis Training Curriculum Outline:

o Downloading FSP DCR Data
= Data Extraction
= Qverview of DCR Data Extract Files

o Utilizing the Partner-Level Report Templates
= |mporting New Data
= Utilizing the Browse Partner Template
= Utilizing the Run Partner Report Template

o Developing the Analytical Report in Access from Application Note #1
= Creating Supporting Queries
= Basic Statistical Analysis Formulas
= Presenting Data in a Report

o Developing the Analytical Report in Excel from Application Note #1
= (Creating New Fields
= Generating a Pivot Table
=  Statistical Measures by Partner
= Statistical Measures for All
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This training was funded by the Mental Health

Services Oversight and Accountability Commission
(MHSOAC).
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Training Overview

1. Download FSP Data from DCR

N

Import FSP Data to PLD Templates
3. Generate Standard Reports

4. Create New Reports

This training covers these main areas of the FSP DCR User Manual (completed 1/17/2012) ,
the Partner-Level Data (PLD) Templates User Manual (completed 1/19/2012) and the
Application Notes (completed 4/5/2012).
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Reference Materials

e FSP DCR Data Dictionary (9/15/2011)
| Home | Systems |

System Messages
ME
Contact Us

Title Somaton Last Updated
System ReqQUIl - oo o

Original DCR § ation (SRS) 04/03/06
Online DCR Rt User Manuals and Instructions 04/09/07

Personal Com| Reference Information (Aid Codes) 08/14/07

Qgsign gng T§ Related Links
Internet Brows: Search 07/10/07

DCR Data Model Options Analysis 01/26/06
MHSA DCR Data Model 02/08/06

[ ESP DCR Data Dictionary | 02/16/12
XML Information

An updated version of the FSP DCR Data Dictionary was completed on 9/15/2011, and it
can be accessed on ITWS through the MHSA Information menu, by selecting the Technical
Information submenu and then clicking to download the FSP DCR Data Dictionary.
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/ =

Reference Materials

e FSP DCR User Manual (completed
1/17/2012)

e ettt iome | Systers | wrisA infomation | Functions | Utites | Support | Logout [ et A e sttt
MHSA _SystemMessages ructions
Training for the COMactUs Outcomes Assessment
€Sl information
Currently, the DMH Performance Qutcomes and Quality Improveme  Frequently Asked Questions for counties who are preparing to collect and submit Full Service
Partnership (FSP) Outcomes Assessment data. County staff will not £ 7 eetings. kchnology Web Services (ITWS) Mental Health Services Act (MHSA) data
system and submit data until they are ‘certified" as having received th MHSA Training page at http://www.dmh ca.gov/POQU trainingMHS A asp
for more information. &]
Tide ————— Last Updated
Reference information (Ad Codes)
Related Links 08/18/07
search 02/16/12
0216112
03/07/06
03/07/06
03/07/06

A FSP DCR User Manual was created on 1/17/2012, and it can be accessed on ITWS
through the MHSA Information menu, by selecting the User Manuals and Instructions
submenu and then clicking to download the DCR User Manual.
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Reference Materials
e PLD Templates and User Manual (1/19/2012)

e | oysens | s momaton | runtors | s | supor | Logou |

MHSA _SystemMessages ructions
Training for the COMACLUS Outcomes Assessment
Sl Information
Currently, the DMH Performance Qutcomes and Quality Improveme  Frequently Asked Questions for counties who are preparing to collect and submit Full Service

Parinership (FSP) Outcomes Assessment data. County staff will not £ 7 peetings kehnology Web Services (ITWS) Mental Health Services Act (MHSA) data
system and submit data until they are ‘certified” as having received th MHSA Training page at http:/www.dmh.ca.gov/POQUtrainingMHSA.asp

for more information. I User Manuals and Instructions ]

Reference Information (Aid Codes)
Related Links 06/18/07

Last Updated

0211612
02/16/12

Search

IMH. Traini R iy nts for /MH:
March §ih Webcast CSI ppt 03/07/05
M th_Wi ESP 03/07/06
March_6th_Webcast FSP_handouts pdf 03107106

Partner Level Data Templates were created on 1/19/2012, and the Access Database and
User Manual can be accessed on ITWS through the MHSA Information menu, by selecting
the User Manuals and Instructions submenu and then clicking to download the DCR
Client-Level Report Template.
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Reference Materials

MHSA System Messages

Contact Us
Csl Information

Juality Improveme  Frequently Asked Questions
unty staff will not t |1 peetings
having received th

Training for the

Technical Information

e Application Notes (completed 4/5/2012)
Home | Sysins | wisa ntomaton | Funcons | ites | support | Logout

tfructions
[Outcomes Assessme

for counties who are
tchnology Web Servi
MHSA Training pag

User Manuals and Instructions

Reference Information (Aid Codes)
Related Links

Search

An Application Notes document with instruction for using Microsoft Excel and Microsoft
Access to create reports from FSP data downloads was created on 4/5/2012, and the
document can be accessed on ITWS through the MHSA Information menu, by selecting the
User Manuals and Instructions submenu. (Note: The document had not been posted at
the time of this publication.)
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This Section Covers:

- Downloading FSP Data Files
- CSV Files
o XML Files

This section covers downloading CSV and XML file types.
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Download File Options

e Users can download the data in two file forms:

> XML (Extensible Markup Language) - 3 Files
» PAF
» 3M
» KET

- CSV (Comma Separated Values) - 4 Files
» PAF Residential Fields
» PAF Non-Residential Fields
» 3M
» KET

The FSP DCR offers a function for users with the CA-RW role to download all of the partner
data to which they have access through their group. The data can be downloaded as XML
or CSV files. The XML data downloads into three files (a PAF, a KET and a 3M file). The CSV
data downloads into four files (a PAF Non-Residential with all domains EXCEPT Residential,
a PAF Residential with residential domain information only, a KET and a 3M file). The XML
or CSV files can then be used to perform data analysis and data reporting in other
applications such as MS Excel, MS Access, SPSS or SAS.
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/ e

Download Files

* Log into ITWS and access the FSP DCR
application Transfers menu to download FSP data

Department of Mental Health
MHSA Data Collection and Reporting |

County. County 59 i Home Partnerships Transfers Admin Help |
Download FSP Data Files

it ~ DataDownload |

ILasx Name = @

- —~ - . New Download [

Download FSP Data Files

As seen in this slide, navigate to the Admin menu and Download FSP Data Files submenu,
and select the New Download button.

Refer to the FSP DCR User Manual (completed 1/17/2012) at Chapter 12 “Data Extraction”
beginning on page 155 for step-by-step instructions.
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Download Files
* Select File Type

* Select Form Type
* Enter Date Range (optional)

Department of Mental Health
MHSA Data Collection and Reporting

County. County 53 Home Parmerships  Transfers  Admin  Help 3. R Homs =
% - Data Download /
Gsttame =] [03]

Download Formab--fs csvratrie  ~] SRequired Downioad £SP Data Dictionary =~ February
formation oniy) - |*

PAF (Resicential informa!
Form Type =
Downioad FSP Dats Fles R!qu’

. Date Renge: I 07/012008 {3 Througt Josaoz00s |23 |
.\ (Leave hiank to get all PAF forms 8]

[l comee |

As seen in this slide as step 3, select the “CSV Flat File” or “XML” file type from the
Download Format drop-down box. Make a selection in the Form Type drop-down box to
select one of the available forms to include in the download.

As seen in this slide as step 4, enter a date range for data to be returned. The date range for
the PAF restricts records based on Partnership Date. The date range for the KET and 3M
records restricts based on the date the form was completed (Date Completed field). If a
date range is not entered, all data will be returned.

As seen in this slide as step 5, select the Run button to return the file. You will notice that
the web browser will indicate the request is running. It may take several minutes for the
data file to download.

Currently, the FSP DCR will only support downloads of files of approximately < 40 MB.
Larger files may cause the FSP DCR to produce an error after several minutes. Reduce the
size of the file by restricting to a smaller date range, and retry the download.

Save the file, and return to the menu to download the other data files. For XML file type,
download 3 files including the PAF, KET and 3M. For CSV file type, download 4 files
including the PAF-Residential, PAF-Non-Residential, KET and 3M.

Refer to the FSP DCR User Manual (completed 1/17/2012) at Chapter 12 “Data Extraction”
beginning on page 155 for step-by-step instructions.
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CSV Data File

* Values are separated by commas
» Can export into Microsoft Excel, Access, SPSS, SAS, etc.

=10/ x|

35€55MmentGUID, CountyID,CSINumber ,GlobalID,CountyFSPID, Name,Partnershipbate,Assessmentbate,Dateofsirth,csIipateofsirth,Gender ETt a
(Twelve, Homﬂess_Pas{Twﬂveoccurences Home16ss_| Pastmelvena\{s ,Homeless_priorTwelve, Individualplacement_PastTwelveoccurences, Tndiy
T_i Pastrwe'lvenays CommunityTr eatment_| priorTwelve,ResidentialTreatment_pastTwelveoccurences,ResidentialTreatment_ Pasl:Twe1veDays,Rs
ag- Zld bads-9984 5d8ba208, 89,000000123,074F 58f7-9aa0-498d-987a-36fa4db02797 .000000123 5",11/2/2010,11/2
d6b658ae- CZTE 46ed-ad73-75fd2ea63116,89, 000000054 0b9cf2ch-c724-41cb-98a9-ecad90a55eff, 000000064 .4/7/2009,4/7/:
e1e31982-597c-49cd-82f2-ec1398eb4 990, 89,000000015, 10ecb79a5-1130-4b6b-9959- 5f710476cdc0,000000015 5",6/7/2007,6/7/:
aach5:4—bZOf—Qezd—b193—?<dd34f?3h04,89.000000106.0f3e5f66—89&f—465?—3919—8SSabOFlf?ff,0 0000106, "Jane, Jane 028".12/3/2010,12/3
e9f48b08-9947 -4f c3-88d1-c2d94 5c9bb92, 89,000000059,115a7401-4320-48c5-be98-5d1797b6906f , 000000059, "Iohn, John 059",7/8/2008,7/8/%
76bbd744 -0d0f -444 a-994d-ef0b378d3bbc , 89, 000000017 ,15d287 3f -0501 -4 dbd-Bc2d-9f 52057ddd7 3,000000017 , " John, John 017",3/12/2008,3/12
02595886-e7be-4905-ad5a-11cfa37397¢9,89,000000046,19cb7956-3373-48d0-8c19-f10346cfa657 ,000000046, " John, John 046",12/17/2008,12/
085248a7-8c74-4154-a781-e673243b4585,89,000000134 ,1a312cba-37e5-4e2f-bcdf-b3f9628b138F,000000134, " Jane, Jane 056 »1/11/2011, 1/}}

b894d2ff-921c-4d3f-9a7e-82a668362cf7,89,000000020,1b5eaee0-9bdd-45b9-boda-28f0cI4b9380e, 000000020
c1f57¢23-f078-423b-97a0-dc5eal60f 51, 89,000000072,1b9cedlc-8d7 5-4eee-9898-2a70b18d7ebl, 000000072
921eb07b-ac96-40de-acf4-1b32eee89fea, 89,000000026,1d554b0d-e177 -4bb5-a514-e0ee5e0528b0, 000000026

7c6d1013-78bd-48f7-9a32-222e42e30bed, 89,000000129, leZthC add9-4d2e-a77a-7f5abgb623f4,000000129
22b39886-0b62-466d-84be-8a57 56e7 5bb2, 89,000000142,2353a1d1-35f9-4921 -bebe-39ed2140a35¢, 000000142
c4al5dae-682d-4439-a67a-75062d0905f6,89,000000110,23917306-e067 -4b88-a018-35d297d0cb2e, 000000110
2fb02c1b-6e63-4b95-91a8-47313e178c92, 89 .000000091 .232Fad9?—ff6f—d§el79bfcf60112d00783d +000000091
b7 539ef2-6f5c-4890-abff-74a7707e6c45,89,000000047,2445ca8c-bbaz-4ff0-941b-d68784892fd4 000000047
a62bed8b-df22-4d5f-baed-18628f76701b, 89,000000098,2579cd57-9100-4949-8bb5-f7d94aad4a167 ,000000098
014b4931-6153-4a5b-845f-dbb5e7b9c79a,89,000000109,261a339a-0712-4a13-90eb-5e667c412cad, 000000109
aSGadeZ—beb 4410-876b-40d6e10ce401,89,000000148, 214 37b4d-c1bd -4be5-agb0-e24 Secc2b7as, 000000148
60551F54-8313-440d-2247-467F0a552784 , 89000000140, 2e17d1d8-Fa2d-4 56e-bbad -5 32dd19686¢ , 000000140
al 9a2- 2852fc4:5a96 89,000000093,2e480185-b867-4204-bc09-cl3a57a290e8,000000093, "Jane, Jane 015",4/27/2010,4/27

-7fd6- -853c-00a96462F 348, 89, 000000023 , 34 3ef4e2-8883-4616-8e56-6c91a0089fe0, 000000023, "John, John 023",2/25/2008,2/2¢
93677Bb7 !d!B 4d50 8481~ a?dddb559623 89.000000060. 3624de62-735f-4cBa-8655-7ad37a6f1254 .000000060.. John. John 060".10/1/2008.10/1

ane, Jane 020" 9/27/2010 9/2:
ane, Jane 031",3/19/2009,3/1¢
ane, Jane 070".9/28/2010,9/2!
ane, Jane 062",5/16/2011,5/1¢€

This slide displays an example of the CSV file contents opened in the Notepad application.
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XML Data File

® Values and data structure defined

* Can import into Microsoft Access, SQL Server or other
relational database supported environment.

i DCR_311_FY0809.xmi - Notepad . o =lolx|
Fle Edt Format View Help

[<DCR> -
<xs:schema id="DCR" xm‘lns-"' xmins : xs=" h::p //www w3. org/zooi/mLschema xmlns:msdata="urn:schemas- m\crosoft -com:xml-msdata”> g
<xs:element name="DCR" msdata:IsDataset="true” msdata:Locale="en-us" msdata:enforceconstraints="rals
<xs:complexType>
<xs:choice minoccurs="0" maxoccurs="unbounded">
<xs:element name="Assessment’>
<xs:complexType>
<xs:sequence>
<xs:element name=""AssessmentID” type="xs:long" minoccurs="0"
<xs:element name='AssessmentGUID" msdata:DataType="system.Guid, mscorlib, version=2.0.0.0, culture=neutral, Publ
<xs:element name="CountyID" minoccurs="0">
<XS: 51mp!eType>
<xs:restriction base="xs:string">
<xs:maxLength value="2" />
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="CSINumber"” minOccurs="0">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:maxLength value="9
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="GlobaliD" msdata:DataType="System.Guid, mscorlib, version=2.0.0.0, culture=neutral, Publickeyl

This slide displays an example of the SML file contents opened in the Notepad application.
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This Section Covers:

> Overview of the PLD Templates
- Browse Partner Data Template

- Run Partner Report Template

o Encryption of PLD Templates
oImporting Data Extracts to PLD Templates

This section covers an overview, encryption and data importing for the PLD Templates.
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PLD Templates Overview

» Provides a Data Extract Warehouse

it

@

@

Facilitates Data File Import

®

Contains Pre-Defined Tables and Field Definitions

®

Contains an Automated Process for Replacing Old Extracts
with New Extracts

@

Provides Form Layout of Each Partner’s Complete Data

®

» Provides Reports of Each Partner’s Complete Data

@

Provides an Environment for Creating New Reports

The Partner-Level Data (PLD) Templates act as a data extract warehouse and provide fully
defined tables to which the DCR CSV files can be easily imported. The PLD Templates also
provide tools and instructions to facilitate the import of the DCR CSV files into Microsoft
Access.

The PLD Templates contain pre-defined tables which incorporate the coding values for the
fields within the CSV files, according to the DCR FSP Data Dictionary. The PLD Templates
also include dimension tables which can be used to translate the coding values within the
FSP data fields into useful terms and categories. All of these tables are defined already for
users utilizing the PLD Templates. The PLD Templates also provide an automated process
for clearing and updating data for new DCR CSV downloads.

The PLD Templates are designed to provide a comprehensive summary of a partner’s Full
Service Partnership (FSP) Data Collection and Reporting System (DCR) partnership data for
the purposes of data quality. The PLD Templates display and organize domain data for the
partnership’s current status and history in the last 12 months before joining the FSP.
(Information on the time prior to the last 12 months before joining the FSP is not included
in these templates.) All administrative changes, such as program or coordinator changes,
are also displayed within PLD Templates.

The Application Notes covered later in this training will exemplify how the PLD Templates
provide an environment for creating new reports from the FSP data files.
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/ e —

PLD Templates Overview

* Interface for Importing and Viewing Partner Data

2] FrontPage

FSP DCR Partner-Level Data Templates

Browse Partner Data Run Partner Report Import New
Data Download

Find a Partner's Data - View Partner Report - from DCR .csv Files
Search by ID Search by ID

Export PDF Report -
Search by ID

Browse All Partners'
Data

Find a Partner's Data -

Find All Partners’ Data
Search by Name

for a Coordinator

When the PLD Templates file is first opened, a front page is displayed. From the front page,
there are two main templates which can be accessed through the PLD Templates. There is
also a section for clearing the old data extract and importing a new data extract.

The two templates available in the PLD Templates are:

1. Browse Partner Data (BPD) Template
2. Run Partner Report (RPR) Template
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Browse Partner Data Template

5] FrentPage | 3] Partner_info
San Francisco Partner Level Report

10/06/2011

PARTNER INFORMATION

Partner Name Doe, John Pal 2/20/2010
County Partner ID Pa Inactive
Global ID Dat 11/28/2010
€SI Number Program 3200,Citywide Adult
Gender M
Age Group Adult
DCR Date of Birth 1/1/1965
CS1 Date of Birth 1/1/1965
€Sl New Race
Complete
Jail [ prison
€51 0ld Race
Hispanic N

DOMAIN DATA FOR: Total 3Ms Due: 3

3Ms | Admin Changes | D1: Residential | D2: Education | D3: Employment | D4: Financial | D5: Legal | D6: Emergency | D7-D8: Health Substance | D9: ADL | D10: IADL

The BPD template allows users to browse through the data of all of the partnerships. As
seen in this slide, the BPD template displays an overview of the partnership information

and a tab for each domain.

By selecting each tab, users can review all of the FSP data reported for a partnership.
Alternatively, users can select one tab of domain information, such as the D5: Legal domain
for example, and then scroll through each partnership to browse just the data reported for

that domain (e.g., legal) for each partnership.
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Browse Partner Data Template

* Four Ways to Access the BPD Template

— = =S

FSP DCR Partner-Level Data Templates

Browse Partner Data Run Partner Report

View Partner Report -
Search by ID

Export PDF Report -
Search by ID

Data

Browse All Partners'
Search by ID

Find a Partner's Data - ]

Find a Partner's Data -

Find All Partners’ Data
Search by Name

for a Coordinator

Import New
Data Download
from DCR .csv Files

Instructions

There are four buttons on the front page to access the BPD Template, which will help filter

the number of partnerships displayed in the template.

The Four Ways to Access the BPD Template:

1. Browse All Partners displays all partnerships downloaded from the FSP DCR.

2. Find All Partners’ Data for a Coordinator displays all partnerships for a coordinator

based on entering any part of the coordinator ID.

3. Find a Partner’s Data — Search by ID displays the partnership data for a partner by CSI

number or by FSP DCR Global ID.

4. Find a Partner’s Data — Search by Name displays the partnership data for a partner

based on entering any part of a partner’s name.
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The RPR template produces a printable report of one partnership’s data. As seen in this
slide, the RPR template displays an overview of the partnership information in a multi-page
report which is separated into sections by domain.
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/ e —

Run Partner Report Template
* Two Ways to Access the RPR Template

FSP DCR Partner-Level Data Templates

Browse Partner Data Run Partner Report Import New
Data Download

Find a Partner's Data - View Partner Report - from DCR .csv Files
Search by ID Search by ID
Export PDF Report -

Browse All Partners'
Data

Find a Partner's Data -
Search by Name

Find All Partners’ Data
for a Coordinator

Users can choose to view the partnership report online, print the report or save a PDF of
the report on their secure drive/network. A user must have available either the CSI number
or the Global ID of a partnership in order to access this template. There are two buttons to
launch the RPR template.

The Two Ways to Access the RPR Template:

1. View Partner Report — Search by ID: Displays a printable partnership data report for a
partnership by CSI number or by FSP DCR Global ID.

2. Export PDF Report — Search by ID: Saves a partnership data report as a PDF at a chosen
location on the user’s drive/network.
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Encryption

Before importing data into the PLD Templates, you can
encrypt the database with a password (Access 2010 or later)

DCR_Client-Level-Report 20111026 - Encrypted - Copy : Datat

I seve

Bl Save Object As

Information about DCR_Client-Level-Report

@) save Database As

»  Save 35 Adobe PDF

° Compact & Repair

5 Open (855 Help prevent and correct database file problems by using Compact and
) Repar.

" Close Database Compact &

Repair Database
@) OCR_Client-Level-R.
@) DCR_Client-Level-R. /
g Encrypt with Password
@) DCR_Client-Level-R.
B) DR cuent.Leve Ucapa u:d o restrict access o your dam - Files that use the 2007
@) DCR _Client-Level-R Microsoft Access file format or late ncrypte

Encr)ptmh

Pass

0o 'assword
Recent

The PLD templates come empty of data and equipped with an encrypted password, which
will be provided to each Mental Health Director. The encrypted password can be changed.
It is most efficient to decrypt and re-encrypt the PLD templates when they are clear of
data.

Refer to the PLD Templates User Manual (completed 1/19/2012) at Chapter 1 “Changing
the Encrypted Password” beginning on page 10 for step-by-step instructions.
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Importing New Data Extracts

] Frontage

FSP DCR Partner-Level Data Templates

Browse Partner Data Run Partner Report Import New
Data Download

Browse All Partners’ Find a Partner’s Data - View Partner Report - from DCR csv Files
Data Search by ID Search by ID
Find All Partners’ Data Find a Partner's Data - Export PDF Report - Instruct
for a Coordinator Search by Name Search by 1D BEIUCHIOnS

As mentioned previously, the PLD Templates come empty of data. It is recommended that
users store an empty copy of the PLD Templates as a backup in the event that Microsoft
Access file corruption issues arise while utilizing the PLD Templates. The PLD Templates are
designed for use with the DCR CSV files, which can be downloaded from the online FSP
DCR. Users must use the downloaded data files from the online FSP DCR application.

The PLD Templates are designed to work with one entire set of the four downloaded FSP
DCR CSV files (PAF Residence, PAF Non-Residence, KET and 3M) at a time. Therefore, when
a new updated set of files is downloaded for use with the templates, the old data must be

cleared from the database.

With the PLD Template open in Microsoft Access, as seen in this slide, select the
Instructions button from the front page.
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P =

Importing New Data Extracts

| _T] FrontPage | Elimmim:m;s

Instructions for Importing New Data

These instructions allow users to update the data in this database utilizing the four comma separated values (CSV) data files downloaded from
the FSP DCR. The four CSV files required to perform this data import are:

1. PAF Residential
2. PAF Non-residential
3. KET
4.3M
(Refer to the Chapter 12 of the FSP DCR User Guide for further information regarding downloading the DCR CSV files.)

Before beginning the instructions below, close all open forms, queries and reports, except the FrontPage form.

Step 1: Remove Old Data - click on the button below to run a program ensure the database is cleared of

any current data.
)

All of the data is dear from the database.

>> Clear Data <<

Step 2: Compact and Repair the Database - click tabase" button in the File Menu.

Information about DCR_Client-Level-Report

After opening the instructions for importing new data, perform Step 1 from the instructions
to clear the data from the database. By selecting the [>> Clear Data <<] button, a macro
will run to clear all of the existing data in the database. If no data exists in the database,
performing this step will not harm the PLD Templates. As seen in this slide, a pop-up
message will alert you when the process is complete.

Note: Existing data must be cleared before using the PLD Templates with new data
downloads. If it is desired to use the PLD Templates with both the historic and current sets
of downloaded DCR CSV files, then a copy of the PLD Templates file can be made before
clearing the historic data such that one file will contain the historic data and the other will
be cleared and used to import the current data.
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Importing New Data Extracts

]-FrontPage. | ] Newbata Instructions

Step 1: Remove Old Data - click on the button below to run a program ensure the database is cleared of
any current data.

>> Clear Data <<

Compact and Repair the Database - click on the "Compact and Repair Database" button in the File Menu.

Step 2:

R, Caare et

e Bt rves Repent 0011335 - Eacreisd Gataba
=
P Information about DCR_Client-Level-Report

Step 3: Import New Data Files (previously downloaded from the FSP DCR).

B As seen in the image below, select the External Data tab above and click on the Text File to invoke the import wizard.

= M 0 Bacs a
B S B0 w2 wd =]

aved Excel Test XML PDF  E-mail Manage

B More » Replies

Excel Access ODBC ¢
Database Aore *  Exports File  File orXps
Export

Data

Perform Step 2 to compact and repair the empty PLD Templates. Microsoft Access may
close the Instructions tab during the compact and repair process. Simply re-open the tab
by selecting the Instructions button on the front page and continue the data import

process.
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Importing New Data Extracts

-2|_Fron c"l; _| NewData.

Step 3: Import New Data Files (previously downloaded from the FSP DCR).

| As seen in the image below, select the External Data tab above and click on the Text File to invoke the import wizard.

—

s P B fredfee FAM A MM 2 &) Access ry |
' 3 Y == ] B B 5 B =
i I BB B ... B SRS SRR S,
Saved b Excel Access ODBC Saved Excel Tet XML POF  E-mail

Manage
Imports M Databaze MAMore *  Eqports

File  File or¥ps Z More +
Import & Link

Export

Replies
Collect Data

3] W‘\

Partner-Level Complete Data Templates

—_———— —— — —  —— —

m As seen in the image below, select Browse to locate the PAF-Residential file on your drive/network. Select to append the data to the
existing [DCR_PAFRes] table from the drop-down menu. Select OK.

- Xt
Select the source and destnaton of the data g D

Somofy the source of e data.

e

==

Perform Step 3 to import the current data files of FSP DCR data. Select from the menu
External Data and then Text File in the Import & Link section.
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Importing New Data Extracts

3ix

Select the source and destnaton of the data

Speofy the source of the data.

Blename: [c:ers\OAC 1 Documents PAPRes.csv Ecowse..

Speafy how and where you mant 1o store the data in the current database.

¢ Import the source data into a new table in the current database.
llhmﬂummmm—dm&l!nmﬂ:ﬁ‘ﬁmmmmmhm
with h tothe n .

& Append a copy of the records to the table: [ocr parees =]
o the source data wil not be reflected in the database.
" Link to the data source by creating a hnked table.

Access wil reate o table ot wil mantan a nk to the source data. You cannot change or delete data that s Irked to 8 text fle.
However, you can add new records.

Five || e |

As seen in this slide, select Browse to locate the PAF-Residential file you downloaded from

ITWS to your drive/network. Select to append the data to the existing [DCR_PAFRes] table
from the drop-down menu. Select OK.
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Importing New Data Extracts

3] import Text Wizard 2

Your data seems to be in 2 Delmited format. If it sn't, choose the format that more correctly
describes your data.

[_Gw-()\-mm:mw&m&umw ]
€ Fooed Width - Fiekds are algned in columns with spaces between each fidd

As seen in this slide, select the Delimited toggle in the following screen. Select Next.
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Importing New Data Extracts

3
What delimiter separates your fields? Select the appropriate delimiter and see how your text is affected in the preview below.

Choose the delimiter that separates your fields:

 Iab rseuudmrapa C Other: [

[ Frstow Contans Fed Names | [ rexowite: [ 1 |

As seen in this slide, select the Comma radio button, check the First Row Contains Field
Names box, and set the Text Qualifier to the quotes symbol. Select Finish.
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[

Importing New Data Extracts

* You will be alerted here if there were errors in the
import

2%

Save Import Steps

g fle 'C: \Jsers\OAC _UET_C ¥ VIDCR_PAFres_ALL.csv' 10 table
‘DCR_PAFRes'.

Do you want to save these import steps? This will allow you to quickly repeat the operation without using the wizard.

™ saye import steps.

As seen in this slide, after each file is imported, a pop-up screen will alert you that the
process is complete. The pop-up screen will also alert you if any errors were present in the
import. Any errors from the data import will be saved in a table noted on the pop-up
screen. (It is not necessary to save import steps.)

Note: The “CreatedDate” from the 3M CSV file may be corrupt in the FSP DCR data
downloaded file. Although all of the other fields will import correctly, the “CreatedDate”
field may not import with each 3M record. This is okay and it will not affect the use of the
PLD Templates. If this occurs, the pop-up screen will alert you that there were errors on
import, and the table of errors can be reviewed. A review of the table of errors will show
that the only field with error was the “CreatedDate” field because of a “Type Conversion
Failure”.

Errors that occur during data import can be reviewed in the Microsoft Access table
generated from the import process. Refer to the PLD Templates User Manual (completed
1/19/2012) at Chapter 2 at the section “Reviewing Data Import Errors” beginning on page
19 for step-by-step instructions.
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Importing New Data Extracts

Repeat Step 3 until all CSV files are imported:

* Import PAF Residential File into [DCR_PAFRes] table

* Import PAF Non-residential file into [DCR_PAFnonRes] table
* Import KET file into [DCR_KETs] table

* Import 3M file into [DCR_3M] table

Step 3 will be repeated until all four CSV files have been uploaded into the appropriate
tables in the PLD Templates:

¢ Import the PAF Residential File into the [DCR_PAFRes] table

¢ Import the PAF Non-residential file into the [DCR_PAFnonRes] table
¢ Import the KET file into the [DCR_KETs] table

¢ Import the 3M file into the [DCR_3M] table
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Importing New Data Extracts

¢ Very Important! Don'’t forget to click button to Run Update.

5] FrontPage | =] NewData_Instructions.

‘Docse T deimter Tt seodates O feds I
Cpb o [ poma Jrmme o obe [ Enter Parameter Value: 21|
([ ot corvarmrires ) | =) Enter Date of Data File Download

1/15/201
M Repeat Step 3 to import the remaining files into the tables as follows: I /152012

>Import the PAF Non-residential file into the [DCR_PAFnonRes] table [Il B
>Import the KET file into the [DCR_KETs] table 4

>Import the 3M file into the [DCR_3M] table

Note: If you make a mistake importing the files, start over from step 1 to clear all data from the database.

Step 4: Run Data Update - click on the button below to run the database update to utilize the new data files.
Enter the date the new data files were downloaded from the FSP DCR when prompted.

RS L. UL FIT LI (This may toke several minutes. A message will appear when the process is complete.)

application as well as any reports generated from this data contain Protected Health Information (PHI) which must be protected with

dministrati hnical and physical Js as required by law pursuant to the Health bility and Acc bili
Act of 1996 (HIPAA) Security Rule (45 CFR Part 160 and Part 164, Subparts A and E,) the Health Information Technology for Economic
and Clinical Health Act (HITECH Act), the California Security Breach Information Act (SB-1386,) and other state and federal law.
Unauthorized use or disclosure is prohibited. It is the responsibility of the user of the PLD Templates to ensure the confidentiality of
the PHI of partners in accerdance with the oforementioned lows and the user’s organization's information security policies and
procedures.

Perform Step 4 by selecting the [>> Run Update <<] button. This will run a macro which will
make the data available to the templates. When prompted, enter the date the data was
downloaded from the DCR or the date to which the data represents current information for
the partner and select OK.

Note: The new data will not be available for viewing through the PLD Templates until the

[>> Run Update <<] macro is run. The macro generates the necessary temporary tables
based on a series of Microsoft Access queries.
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This Section Covers:

o Using the Browse Partner Data Template

» Browse All Partners’ Data

- Find All Partners’ Data by Coordinator ID
» Find a Partner’s Data - Search by ID

» Find a Partner’s Data — Search by Name

o Using the Run Partner Report Template
» View Partner Report — Search by ID
» Export PDF Report — Search by ID

This section covers the utility and features of the Browse Partner Data and the Run Partner
Report Templates.
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Browse Partner Data Template

o Select a button and enter criteria to find partners

Browse Partner Data

Browse All Partners' ’

Find a Partner's Data - ‘

Data Search by ID
Find All Partners' Data Find a Partner's Data -
for a Coordinator Search by Name

The BPD template includes several options to browse partners’ data, which can be
accessed through the four buttons in the “Browse Partner Data” section of the front page
as seen in this slide. You can browse through all partners’ partnership data or search by
partner ID, partner name or coordinator ID.

Selecting any of the four buttons and entering appropriate criteria when required will

display the BPD template. The Browse All Partners’ Data requires no criteria and will display
every partner.
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Browse Partner Data Template

I | ] Frontpage | ] partner.into I

Browse Partner Data Template

1/15/2012

PARTNER INFORMATION

Partner Name
County Partner 1D
Global ID

€SI Number

Gender
DCR Date of Birth

CSi Date of Birth
€SI New Race

€51 Old Race

Starting Age Group  Adult

lane, Jane 079
000000157
b8258ea5-5€9c-4a66-a82-d393¢1883676
000000157
F

Ending Age Group Adult
7/24/1963
7/24/1963

9/20/2011

tus  Active

9/20/2011
Adult FsP

Sam, Sam
1234

Complete
Homeless Shefter

Déf.i in 117

artnership

Hispanic N

DOMAIN DATA FOR: Jane, Jane 079 Total 3Ms Due: 1

| | 3Ms | Admin. Changes | D1: Residential | D2: Education | D3: Employment | D4: Financial | | D5: Legal | D6: Emergency | D7-D8: Health Substance | D9; ADL | D10: IADL

r\ﬁumu H 10157 + M

search

After opening the BPD template, notice that in Microsoft Access 2010, by default, the
template opens as another tab in the application. At the top of the BPD template, the
“Data Displayed Through:” date signifies the last time the data in the PLD templates was
updated from FSP DCR data file downloads. This is the date which was entered when
selecting the Run Update button from the import page. It is also the date to which the
number of active days in partnership is calculated for partnerships which are still active.
Under the subheading of “Partner Information”, the first partnership’s partner information
will be displayed.

In this slide, the example partnership was still active and had existed for 117 days at the
time of data download on 1/15/2012.

There may be many partnerships available to browse. The total amount of partnerships and
the current order of the partnership being viewed are displayed at the bottom left-hand
corner of the report in the Record navigation box. As seen in this slide, the first of 157 total
partnerships is displayed in this example.

You can navigate to the next or previous partnership by clicking on the arrows to the left
and right of the Record navigation box. Additionally, you can locate a partnership in a
specific order by clicking on the Record navigation box and manually typing in a number
within the range of the available partnership count and pressing Enter. The form will jump
to the partnership associated with that order number. This may be useful when the
partnerships are sorted in the form by a specific order. By default, the partnerships are
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sorted by partnership status and partnership date, such that the active partnerships with the
most recent partnership dates appear first. However, the partnerships can be sorted by other
fields in the template.

Refer to the PLD Templates User Manual (completed 1/19/2012) at Chapter 3 “The Browse

Partner Data (BPD) Template” beginning on page 22 for step-by-step instructions of scrolling
through partners in the BPD Template.
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Browse Partner Data Template

> Sorting Partners

A.] A ¥ OCR_Client-Level-Report_20111026 : Database (Access

“ Home External Data Acrobat /

8 | Ascenaing 3 }i

Find

%l Descending = GoTo~

=3 o

As mentioned, the partnerships are sorted by partnership status and partnership date by
default, such that the active partnerships with the most recent partnership dates appear
first. However, the partnerships can be sorted by other fields in the template.

To sort the order of the partnerships in a different order, place your cursor in the field in
the “Partner Information” section of the BPD template which you would like to use to sort
the partnerships (e.g., Age Group). As seen in this slide, select the Home menu and select
either the Ascending or Descending button to sort the partnerships by the selected field.
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Browse Partner Data Template

Finding Partners - Select a field to search in the partner
information section

AJ d ¥ DR _Chent-Level-Report_20111026 : Database (Access
External Data ACTObI /
E S 3 #
i = = GoTo~
fres Fing
o Select~
CEE— 2ix]
Find |
FindWhat:  [Doe, John =] | FindNext
Cancel
Look In: Current field ']
Match: Whole Field -
Search: Al -
I” Match Case [V Search Fields As Formatted

To find a particular partner, place your cursor in the field in the “Partner Information”

section of the BPD template which you would like to use to find a partnership (e.g., Partner
Name).

As seen in this slide, select the Home menu and then select the Find button.

As seen in this slide, enter the criteria for the search. In this example, we are searching the
partner name field to find a specific partner by name.

The Find box will remain open, and you can select the Find Next button to jump to the next
partnership with matching search criteria.

Note: Selecting to search information under the “Domain Data For” sections in the lower

half of the BPD template will only search for data within the partnership which is currently
being displayed. The search will not bring up other partnership’s matching data.
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Browse Partner Data Template

> Data for the partnership is displayed in the tabs

- 3Ms, Administrative Changes and all Domain Data

> This image displays the 3M Data

DOMAIN DATA FOR: Jane, Jane 009 Total 3Ms Due: 5

3Ms | Admin. Changes | D1: Residential | D2: Education | D3: Employment | D4: Financial | D5: Legal | D6: Emergency i D7-D8: Health Substance D3: ADL | D10: 1ADL |

Total 3Ms Due: 5

Date Days in i For Quarter Age Group at Time of Assessment

4/14/2010 77 1 Child
8/4/2010 189 2 Child
10/27/2010 273 3 child
1/27/2011 365 4 Child
4/15/2011 447 5 Child

Under the “Domain Data For” subheading, there are tabs for the partnership’s information
such as their legal, financial and employment data. All domain options are displayed in this
slide. Data associated with a tab will be displayed by clicking on the tab. A vertical scroll bar
will appear if necessary to allow scrolling within the table embedded in the tab.

In this example, the partner had five 3Ms due, and all five 3Ms were completed.
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Browse Partner Data Template

> Admin. Changes Tab Example

f T T r -
! 3Ms | Admin. Changes | D1: Residential I D2: Education | D3: Employment | D4: Financial ‘ D5: Legal | D6: Emergency | D7-D8: Health Substance | D9: ADL | D10: IADL

| HISTORY OF CHANGES TO ADMINISTRATIVE DATA:

Assessment Date Change  Provider Date Change  Program  Dote Change Coordinator Date Change  Status  Discontinue Date Change  AB2I4  Date Change GHI Status Date Change 1HSA Status.
Date  of Provider of Program of Coor. of Status Resson  of ABAM  Sutus  ofGHI MHSA

The Admin. Changes tab displays a list of all administrative changes reported for the
partnership, including assessment date and dates of change.

In this example, the partnership began on 2/20/2008 and changed coordinators from Joe to
Bob to Herald. The partnership was discontinued on 8/18/2010 for having met goals.
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Browse Partner Data Template

> D1: Residential tab example

; 3Ms | Admin. Changes | D1: Residential | D2: Educatmn‘ D3: Employment | D4: Financial | D5: Legal ‘DB: Emergency | D7-D8: Health Substance } D3: ADL DlD:IADL!

DAYS AT RESIDENTIAL SETTINGS IN 12 MONTHS BEFORE FSP:

Tomoays Wm  We  AX Srge Fomw foser Em  rome mav ASD Cop Conm MedcaPnon Sme GB Gp
Reponss  Pyess Orer Acre Room Reahe Mo Shelw eSS Pom Uieg Pomn CFe KOs MOS) Poyn Mome rome T
Past1z Famay o e on M

Comm Res NS Nasmg 04 i Prson omer um
™ Poysc Pryen Sezing sesing

Rescersa sezng Yooy

§id

o
3
camp

Homeless 365 218 120

DAYS AT RESIDENTIAL SETTINGS DURING FSP:

Date Residential  Daysin Residential Setting Length at Assessment Date Record Created

Change FSP Setting Date
11/20/2008 0 Homeless 1 11/20/2008  12/03/08 9:57:06 AM
12/1/2008 11 Residential Treatment 91 12/5/2008  02/09/09 1:54:54 PM
3/2/2009 102 Emergency Shelter 36 3/11/2009  03/12/09 2:52:05PM
4/7/2009 138 Apartment Alone 482 6/19/2009  06/19/09 1:19:31PM

The D1: Residential tab displays the past 12 months of residential information and a list of
all residential status changes during the program.

In this example, the partner spent 218 days and 120 days in emergency shelter and
homeless, respectively, in the 12 months before the partnership. During the partnership,
the partner spent 11 days homeless, 91 days in residential treatment, 36 days in an
emergency shelter, and spent the final 482 days in an apartment alone.
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Browse Partner Data Template

> D2: Education example

| 3Ms | Admin. Changes | D1: Residential | D2: Education | D3: Employment | Da: Financial | DS: Legal | D6: Emergency | D7-DS: Health Substance | D3: ADL | D10 IADL

EDUCATION IN 12 MONTHS BEFORE F5P:

Assessment Age Time Period Ed for Ed for Attend- Grades %Suspen- ZExpul- Weeks Weeksin Weeksin Weeksin Weeksin Weeksin  Com- Ed
Date Emo. Anoth.  ance sions  sions Notln  High  Tech. Comm.  Grad Other  pleted  Recov.
Dist Reas. School School School College School School Pgm.  Goals
7/29/2008 Child  Past12 N/A N/A Good Average
CURRENT EDUCATION STATUS:
Assessment Date of Age  TimePeriod Daysin Highest Ed for Ed.for Attend- Grades Suspen- Expul-  Notln InHigh InTech. In  InGrad InOther Com  Ed
Date Change FSP  Grade Emo. Anoth.  ance sion  sion School School Sehool Comm. School School pleted  Recov.
Dist  Reas. College Pom.  Goals
Start of FSP - 0 Sthgrade No No Very Good
PAF Good
10/14/2008  10/8/2008Child  During FSP 7 Yes
2008 10/17/2008Child  During FSP 80 Yes No Good Below
Ims Average
5/4/2008  5/4/2009Child  During FSP- 279 No Yes Good Good

IMs

The D2: Education tab displays the past 12 months of education information and a list of all
education KET and 3M assessments during the program.

In this example, the partner entered the FSP in 8t grade with very good grades. The
partner had average grades during the previous year. The partner was suspended after 71
days in the partnership as reported on a KET, and the partner’s grades were below average
at the first 3M assessment at day 80 of the partnership. The next 3M assessment submitted
was at 279 days into the partnership, and the partner’s grades were good.
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Browse Partner Data Template

> D3: Employment

aMs | Admin. Changes | D1: Residential | D2: Education | D3: Employment | DA: Financial | DS: Legal | D6: Emergency | D7-D8: Health Substance | D3: ADL | D10: IADL

EMPLOYMENT IN 12 MONTHS BEFORE FSP:
Assessment Age Time: Competitive Employment Supported Employment

i In i Non-Paid Other Emplayment Un-
Date Period Wis  HWk  Wager | Wi HWk WageHr | Wio  HraWk  WageMr |Wks  HrWk  Wager | Whs  HrsWh Wis  HrWk  Wagelr | emplojed
/24/2007 TaY Past12 ‘ o ‘ o | o ‘ a | 7 1| o a5
EMPLOYMENT DURING FSP:
Assessment  Change Date  Age Time  Daysn Competitive Employment i In Non-Paid Other Employment Un.
Date Period  FSP Whs  HrsWk  WogeMr | Wis  HrsWk WapeHr | Wes  HraWk  WageMr | Whs  HraWk  WageHr | Whs HuWk | Wis  HrsWk  Wager | employed

i

The D3: Employment tab displays the past 12 months of employment information and a list
of all employment KET assessments during the program.

In this example, the partner was unemployed for 45 of 52 weeks in the past 12 months and

spent 7 weeks in non-paid employment for 18 hours per week. On day 26 in the FSP, a KET
assessment reported that the partner began work at 25 hours a week for $7.00 per hour.

Page 48 of 128



FSP DCR Data Analysis Training

/ ==

Browse Partner Data Template

5> D4: Financial

3Ms | Admin. Changes | D1: Residential | D2: Education | D3: Employment | Da: Financial | DS: Legal | D6: Emergency | D7-D8: Health Substance | p9: aDL | D10: 1ADL

FINANCIAL SUPPORT IN 12 MONTHS BEFORE FSP:

3/18/2008 Aduft Past 12 ves Yes Yes

FINANCIAL SUPPORT DURING FSP:

Kssess. Ko TmePeriod DaysinFSP Any  Any Any  Any Ay Any  Any  Any Anylom Any Ay Any A Any  Any Ay Any  Any
ment Date Caregiver Wages Spouse Savings Child  Oher  Retire  Veteran Housing Genersl Food TANF  SSI  SSOI  SDI  Tribal  Oher Support
Support  Family  ment Stamps Support

2008 Aduit start of 0 Yes

6/18/2008 Aduit

Rssess- Age Time Period Any Ay Any Ay Any  Amy  Any Anylom Any Ay Ay Aw  Amy  Any Ay Amy  Any
ment Date Caregiver Wages Spouse Savings  Child Other Retire-  Veteran Housing General Food TANF ss1 $S01 sol Tribal Other  Support
Support Family  ment Stamps Support

The DA4: Financial tab displays the past 12 months of financial support information and a

list of all financial support 3M assessments during the program.

In this example, the partner had financial support in the form of spouse, general and food
stamps in the 12 months before the FSP. At the start of the FSP, the partner was receiving
financial support from spouse and food stamps. At the second 3M assessment, the partner

reported financial support from wages and SSI.
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Browse Partner Data Template
> Ds: Legal

| D4: Financial | DS: Legal | D6: Emergency | D7-D8: Health Substance | DS: ADL Dm:IADLl

LEGAL ISSUES IN 12 MONTHS BEFORE FSP:

Assess. Age Time Period Arrested  Probation Parole Conserva- Payee  WiCode Wi Code
ment Date Status Status  torship  Siatus  Status Year
Status
6/7/2007 Child Past12 1 es o N No
LEGAL ISSUES DURING FSP:
Assess Age Time Period Days In Date Amested  Probation  Parole  Conserva.  Payee  WiCode WiCode No.Depen- No Depen-  No. No
ment Date Fsp Change Status Status torship Status Status. Year dentson  dentsin  Dependents Dependents
Status WiCode Foster Care Reunified  Adopted
6/7/2007 chila Star of No No No 0
FSP - PAF
9/7/2007 Child During o 0 0 0
FSP-3M
/! hild During 0
FSP-3M
2/26/2008 TAY During 197 12/21/2007 orr
FSP - KET

The D5: Legal tab displays the past 12 months of legal issues and a list of all KET and 3M
assessment legal issues during the program.

In this example, the partner was arrested one time in the 12 months before partnership
and was on probation upon entering the FSP. No changes were reported on the first two

3M assessments. On day 197 in the FSP, a KET assessment reported that the partner went
off probation.
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Browse Partner Data Template
> D6: Emergency

3Ms | Admin. Changes | D1: Residential ‘ D2: Education | D3: Employment | D4: Financial : D5: Legal | D6: Emergency | D7-D8: Health Substance | D3: ADL \ D10: IADL

EMERGENCY INTERVENTIONS IN 12 MONTHS BEFORE FSP:

Assessment Age Group Time Pefiod No_ of Physical No. of Mental Related
Date Related Emergencies  Emergencies
22 2/2008] Adult Past12 1

EMERGENCY INTERVENTIONS DURING FSP:

Assessment Age Group Time Period Daysin FSP  Date of Emergency Type
Date Emergency
1/16/2009 Adult During FSP - KET 144 1/12/2009 Mental / Substance
2/9/2009 Adult During FSP - KET 166 2/3/2009 Physical Health

2/9/2009 Adult During FSP - KET 170 2/7/2009 Physical Health

The D6: Emergency tab displays the past 12 months of emergency interventions and a list
of all emergency intervention KET assessments during the program.

In this example, the partner reported one mental/substance related emergency in the 12
months before the partnership. During the partnership, the partner had a
mental/substance related emergency at 144 days in the partnership, and the partner had
physical health emergencies on days 166 and 170 in the partnership.
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Browse Partner Data Template

Assessment
Date

12/17/2008

Assessment
Date

12/17/2008
3/10/2009
6/4/2009
10/6/2009

12/14/2009

> D7 & D8: Health and Substance

Age Group Time Period

TaY Past 12

HEALTH AND SUBSTANCE ABUSE DURING FSP:

Age Group Time Period

TAY Start of FSP
TAY During FSP - 3M
TAY During FSP - 3M
TAY During FSP - 3M
TAY During FSP - 3M

HEALTH AND SUBSTANCE ABUSE IN 12 MONTHS BEFORE FSP:

IMs { Admin. Changes | p1: Residential | D2: Education ‘ D3: Employment : D4: Financial | D5: Legal : D6: Emergency | D7-D8: Health Substance | DS: ADL ‘ D10: IADL

Had Physician Ever had Substance

Abuse Problem
No Yes

Days in FSP Has Physici Active Sub ]
Abuse Problem Abuse Services

0 No fes No

83 Yes Yes No

169 Yes Yes Yes

293 Yes Yes Yes

362 Yes Yes Yes

The D7-D8: Health Substance tab displays the past 12 months of health and substance
abuse history and a list of all health and substance abuse 3M assessments during the

program.

In this example, the partner did not have a physician and had a substance abuse problem in
the 12 months before and at the start of the FSP. The partner was not receiving substance
abuse services at the start of the FSP. At the first 3M assessment on day 83, the partner
reported having a physician. At the second 3M assessment on day 169, the partner

reported receiving substance abuse services.
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Browse Partner Data Template
o Dog: Activities of Daily Living (ADL)

| 3Ms | Admin. Changes | D1: Residential | D2: Education | D3: Employment EDA:Fmancral i D5: Legal | D6: Emergency | D7-D8: Health Substance | D3: ADL | D10z 1ADL

ACTIVITIES OF DAILY LIVING (ADL) DURING FSP:

Assessment  Age Group Time Period Daysin Bathing Dressing Toileting Transfer Continence Feeding Walking House
Date FSP Confinement
11/9/2008 Older  During FSP - 3M 270 1-Receivesno - w1
Adult assisanc
2/2/2010 Older  During FSP-3M 355 1R
Adult ass
010 Older  During FSP-3M 445 1-Recaivesno
Adult

The D9: ADL tab displays the ADL 3M assessments for older adults during the program.

In this example, the partner had three 3M assessments during the program, and the ADL
status were captured on days 270, 355 and 445 in the program.
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Browse Partner Data Template

o D1o: Instrumental Activities of Daily Living (IADL)

| 3ms ‘ Admin. Changes | D1: Residential : D2: Education | D3: Employment | Da: Fmanmalj D5: Legal ‘ D6: Emergency% D7-D8: Health Substance D9: ADL | D10: IADL

INSTRUMENTAL ACTIVITIES OF DAILY LIVING (IADL) DURING FSP:

Assessment  Age Group Time Period Daysin Telephone Walking Groceries Meals Housework  Handyman Laundry Medication  Money
Date Fsp Distance
11/9/2008 Older  During FSP - 3M 270 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 2-WithSome  1-WithoutHelp 1-WithoutHelp 1-WithoutHelp
Adult Help
2/2/2010 Older  During FSP-3M 355 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 1-WithoutHelp 2-WithSome  1-WithoutHelp 1-WithoutHelp 1-WithoutHelp
Adult Help
5/3/2010 Older  During FSP-3M 445
Adult

The D10: IADL tab displays the IADL 3M assessments for older adults during the program.
In this example, the partner had three 3M assessments during the program, and the IADL

status was captured on days 270 and 355. The IADL information was not completed for the
3M assessment on day 445 in the program.
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Browse Partner Data Template

> Find All Partner’s Data for a Coordinator Button

Browse Partner Data

Find a Partner's Data -

Data Search by ID

Browse All Partners' ’

Find All Partners' Data Find a Partner's Data - l
for a Coordinator Search by Name |Enter Parameter Value M

Enter part of coordinator ID

[ox]icanoewﬁ

E FrontPage 'E Partner_Info_SearchbyCoor

The Find All Partner’s Data for a Coordinator will apply a filter to the BPD template based
on matching the criteria entered with a coordinator ID. As seen in this slide, selecting this
button will bring up the “Enter Parameter Value” pop-up window. Typing in any portion of a
coordinator ID in the box will apply the filter to the BPD template. The BPD template will
then display only those partnerships with associated coordinator IDs containing the
entered text as any consecutive part of the coordinator ID. For example, entering “Smith”
in the “Enter Parameter Value” pop-up window will display partnerships for all coordinator
IDs with any portion of “Smith” as part of the ID. As seen in this slide, the BPD template will
open in a new tab titled “Partner_Info_SearchbyCoor” with partnership records that are
exclusive to the coordinator ID search performed. The number of partnerships available can
be seen in the Record box in the lower left-hand corner of the screen.
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Browse Partner Data Template

Find a Partner’s Data - Search by ID Button

Browse Partner Data

Find a Partner's Data -

Data Search by ID

Browse All Partners' ’

1

Find ¢ Enter Parameter Value LEJ—%

for a Coordinator

Find All Partners' Data ’

= Enter CSI Number (or press OK to skip and use Global ID on next screen) E{ﬁ,
=
oK [ cancel | W

Enter Parameter Value li&

Enter Global ID (or press OK to skip)

e sl

-5 FrontPage | -z| Partner_Info_SearchbylD

The Find a Partner’s Data — Search by ID button will apply a filter to the BPD template
based on matching the criteria entered with a partner ID. There are two options for
entering partner IDs. You can enter a CSI number in the first pop-up window or enter a
Global ID in the second window.

To search for a specific partnership by partner ID number, click on the Find a Partner’s Data
— Search ID button under the “Browse Partner Data” heading. As seen in this slide, the first
pop-up window that appears will allow you to enter search criteria of CSI number. If known,
enter the CSI number and press OK. If you would prefer to search by Global ID, enter
nothing in this first window and click OK to skip the search by CSI number.

As seen in this slide, the second pop-up window that appears will allow you to enter search
criteria of Global ID. If a CSI Number was already entered in the previous pop-up window,
then click OK to skip the search by Global ID. If the CSI Number was not entered, then enter
a Global ID for a partnership and press OK to continue.

As seen in this slide, the BPD template will open in a new tab titled
“Partner_Info_SearchbylD” with the partnership information for the partnership matching
the partner ID entered into the search box. The number of partnerships for partners with
matching IDs is displayed in the Record box in the lower left-hand corner of the screen.
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Browse Partner Data Template

> Find a Partner’s Data - Search by Name Button

Browse Partner Data

Find a Partner's Data -

Data Search by ID

Browse All Partners' ’

B

Enter Parameter Value ed eS|

Enter any part or all of a parnter's name in the format "Last, First®

[poe, John
[ W

1 j FrontPage [:5] Partner_Info_SearchbyName

Find All Partners' Data
for a Coordinator

Find a Partner's Data -
Search by Name

The Find a Partner’s Data — Search by Name will apply a filter to the BPD template based
on matching the criteria entered with a partner’s name.

As seen in this slide, selecting this button will bring up the “Enter Parameter Value” pop-up
window. Typing in any portion of a partner’s name in the box will apply the filter to the BPD
template. The BPD template will then display only those partnerships which contain the
entered text as any consecutive part of the partner name. For example, entering “Martin”
in the “Enter Parameter Value” pop-up window will display partnership data for all
partnerships with any portion of “Martin” as either their first or last name. The standard
FSP DCR format for the name field is “Last, First”. Therefore, you can conduct a search for a
partnership using the full name with that format. As seen in this slide, for example John
Doe would be found using “Doe, John”.

As seen in this slide, the BPD template will open in a new tab titled
“Partner_Info_SearchbyName” with partnerships matching the search criteria displayed.
The number of partnerships matching the search can be seen in the Record box in the
lower left-hand corner of the screen.
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Run Partner Report Template

> Run one partner report at a time by ID

Run Partner Report ﬂ

View Partner Report - Enter Parameter Value LE&
Search by ID
Enter CSI Number (or press OK to skip and use Global ID on next screen)
Export PDF Report -
Search by ID [k ][ cence |

| Enter Parameter Value (8|S0

Enter Global ID (or press OK to skip)

ﬂ‘_§| FrontPage | |2] Partner_Level_Report

oK [ cancet |

The RPR template includes two options to generate a partnership report, which can be
accessed through the two buttons in the “Run Partner Report” section of the front page as
seen in this slide. The RPR Template can be viewed in Microsoft Access as an Access report
or it can be exported as a PDF file.

The View Partner Report — Search by ID button will display a report within Microsoft
Access, which can be viewed electronically or printed from Microsoft Access. A report for a
partnership is displayed based on matching the criteria entered for a partner ID. There are
two options for entering partner IDs. You can enter a CSI number in the first pop-up
window or enter a Global ID in the second pop-up window.

To display a report for a specific partnership, click on the View Partner Report — Search by
ID button under the “Run Partner Report” heading. As seen in this slide, the first pop-up
window which appears will allow you to enter search criteria of CSI number. If known, enter
the CSI number and press OK. If you would prefer to search by Global ID, click OK to skip
the search by CSI number.

Note: You can use CTRL + V to paste search criteria into the “Enter Parameter Value” pop-
up windows.
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Run Partner Report Template

P v @
x)

PARTNER INFORMATION

Ensng ALeGrow

Navigation Pane

I Hum Lock. | B[] & 7% ) + I

As seen in this slide, the report will open in print preview mode.

As seen in this slide, the Page selector in the lower left-hand corner will allow you to scroll
or jump to any page in the report.

As seen in this slide, a zoom slide-bar in the lower right-hand corner allows you to quickly
enlarge or shrink the view of the report on the screen.

Page 59 of 128



FSP DCR Data Analysis Training

Run Partner Report Template

> The Print Preview ribbon for the report

“ Print Preview | Acrobat

Print | Size Margins [] printDataOnly | Portrait landscape|Columns Page | Zoom | One | Two  More Excel Text PDF  E-mail More  Close Print
v v Setup v | Page | Pages Pages~ File orX - Preview
Zoom

As seen in this slide, The Print Preview ribbon heading has print options. Clicking Print will
print the partnership report. You can also zoom in or out and view the report by more than
one page in the “Zoom” section of the ribbon. The Close Print Preview option will exit the
partner level report and return you to the front page.

Note: The margins of the partner report are set for printing on standard printers. Adjusting

the margins may affect the quality of the report. However, if the report prints extra blank
pages on your printer, then slightly adjusting the margins may solve the issue.
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PARTNER INFORMATION
Partner Name  John, John 063 PatershipDate  4/7/2009 Pyt Sty 595
—_— Total 3Ms Due 6 —

County Partnar D 00D0D0DE3 Partnership Sz inactive
Global ID £1127003-c3 1d-4206-9001-4181807 &7 1c Date sChange 1Y23/2010
€SI Number 000000063 Program Wraparound
Gender M
Starting Age Group TAY Ending AgeGroup TAY
DCR Date of Bith 5/7/1992
CSl Date of Birth 5/7/19%2 "
CSiNewRace  American Native or Alaska Native o

Pending

Referred By Social Services Agency

CS1 Old Race American Native
Hispanic ¥

Page1cf9

The first page of a nine page example report is displayed in this slide. At the top of the RPR
template, the “Data Displayed Through:” date signifies the last time the data in the PLD
templates was updated from FSP DCR data file downloads. The bottom right-hand corner of
the report will display the page number.
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/ PARTNER INFORMATION
Partner Name  John, John 063 Partnership Date af112008 D2y in Parinechip 595
Total 3Ms Due: 6
3M Assessments
AsssamentDate  Dayain Pagnership For Quarter Age Group at Time df Assesament
7 114 1 TAY
184 2 TaY
444 s TAY
535 ] TAY
History of Administrative Changes
Assms-  Dase Prvider Date Program  Date Coonlinator Dae Sumaz Dizzostinse Dxe AB2M Oase GMiStess Date wisa
mestDate Crange Chmge o Change of Changeof Reason  Chamgedl Sues  Ovasgeol Cuamge  Soates
P Program Cosr. Stz e = TN
ron uE % N mmas GEs e Cams  mewes ©EE eeoes oms wioe
P
P —.
----- Page 2019

This slide displays the 3M Assessments and Administrative Changes page of the report.

Page 62 of 128



FSP DCR Data Analysis Training

PARTNER INFORMATION

Fartner Name  John, ohn 063 af7/2008 595
6
Residential Settings
12 Months Before FSP
— Res s B erey TE0n: Wn WR At Sge R Rme Bn o W AsU Cog Commiedcs Anor Swe G 00 Covm Res NASTNSG LT O M J Pexn O Un J—
i e re dve S e o ew e Amw G AT Gee s m PAmme wme % w ak me = st
=it a4 el = o
Juvende Hal/ Camrp .5 3 20
Residential Sentings During FSP
Date Residestid Daysin Reidential S eming Lesghat  AszessmentDate  Record Cmated Date
Crange L4 Semag
yr200 -] With Parents. 20 V772008 04/09/09 24806FM
427200 20 Juvende Hall / Camp. 22 47282008 04/28/09 BSLA8AM
5/192008 a2 Group HMome 12:14 553 S5R1Z0W 052109 11:38:58 AM

This slide displays the Residential Settings Domain page of the report.
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/ PARTNER INFORMATION

Fartner Name  John, John 063 ParmenhipDate  4/7/2009 595
6
Educadon Domain
12 Months Before FSP
Rmemmest DaedCmex  Age  TmePewd B Kk Amm Onas 8 ® Wk Wk Won Wk b WihWee Con 69
Dxe Emo. Ason  amoe Spen Expt Noth Hign Teon Comm. dna OPer e Recow.
okt hem Sox  sis Swed dwon mewel Comg Meesitmod  Fgn  Oaum
PR wr rmau NA WA Gace .

Educaton During FSP
Mssessmese  Dzeof  Age TimePedod Days Mighest Ed  Ed. Musd GradesSuspes Bk Nah b b b b W Com Ed
Daee Crange RFSP  GCode for for  mee ‘don Som Scheol Hgh Tech. Comm Grad Other plesed Pecov.
Emo. School School Colkege School School Pgm.  Goals

d Haakih information page dofs

This slide displays the Education Domain page of the report.
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/ PARTNER INFORMATION

Fartner Name  Joha, John 063 Partnership Date af1/z2009

Emplovment Domain

12 Months Before FSP
e Amessmes Chasge  Age  Teme
Daee Dare

772008 Ty 2112

Employment During FSP
Asessmex Chasge  Age  Teme  Daps
Daze [

47/2008  4OOTAY  Satet ]
F58 - PAF

6
Days I e £ £ £ NosPaid th-
Pesod WFSP lWis Ha/ik WaseMr | Wi Hes'Wi Waserl Wis Hesiic Wasehe | Wis. Mesiii Waseltr| Wio  He/klWis M/t
Comagiin Em. NosPaid Ue
Pesod FSP |Wis HaMik Waseir [Wics HesWi WaoeWe| Wi HestWi WaoeHr Wi, HesiW Wacetr| Wis  HaWk| Wis Haltfc e
ves

This slide displays the Employment Domain page of the report.
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/ PARTNER INFORMATION

fartnerName  John, John 063 Partnership Date  4/7/2009 o 595
Total 3Ms Due: 6
Financial Domain
12 Months Before FSP
e Ammmner  Ax  Tmeferos Amy Am Am A Am Am Am Am  Am Am  Am  Am  Am  Am  Am  Am  Am  Am  Ne (—
o= Cre. Waes toase mviap Ol Ome el Vewns Lan Hos. Genwm foss TAN 8 301 31 Timl Omr Ses
ove oot Faniy  memt - ot oo
P A ves

Financial Support During FSP

Amomet Az TimeferocDipi Amp Am Am Am Am Am Am Am Am Am Am Am Am Am Am  Am  Am  Am  No
o e

Cxe. Wxes soame mving Chdd  Ome Reive. Vewnn Lam  Wox. Ocora ooz TANF M 801 01 Tl Orer Swoon
o Sooat Famiy  mewt ) sames (]
/2008 TaY  smmer o ves
£ -paF
7072008 TaY  During 1 ves
R
107372008 Y Dureg a ves
£ -1
W2/00 TAY  Durng e ves
o -1
U0 TAY  During n ves ves
R
ctected Heaith information Page £ofd

This slide displays the Financial Domain page of the report.
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/ PARTNER INFORMATION

Partner kame  John, John 063 Fartnersh

oome  a/7/2009 595
6
LegalDomain
12 Months Before FSP
Reses- Me  TinePesos Aseszs  Paaion  Prer  Ooemwa  Pame  WiCke  WiCese
— Oz =a ®=z  weme ®Ea Eme var —
wns
= ™
Legal Issues During FSP
Ames Ae  Timeretos Dyt CaeCramge Amsea  Maatos  Pxot  Comens.  Fime  WICK®  WICae  No.Deen NoDeen  NO
mestDan EY) e ®mes  weo  mEa wms Yar  cemceW! Geen  Dependss Depercerss
Cose  FomrCam Rewsfes  Acwms

This slide displays the Legal Domain page of the report.

Page 67 of 128



FSP DCR Data Analysis Training

/ PARTNER INFORMATION

Fartner Name  John, John 063 Farmership Date  4/7/2009 By 592
Emergency Intervention Domain
12 Months Before FSP
— AtMsament  AgeGmip Time Period No.ofPhysical Retated  No. of Mental Related e
ot EmerEnciss Eme G
4/772009 Tar Pz 12 ]

This slide displays the Emergency Intervention Domain page of the report.
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/ PARTNER INFORMATION
Partner Name  John, John 063 Partnership Date  4/7/2009 D T P o shlp 595
Total 3Ms Due 6
Healkh and Substance Abuse Domains
12 Months Before FSP
A3 3403 MRNT Age Grow Time Peanca HaoPhysican Evernao sutstanoce
— D2 AbwmsProoem —
473009 TAY Pami2 =
Health and Substance Abuse During FSP
Age Growp Tims Period DaysinfSP  rasPnysican  Adive Swstance  Reosving Substancs
Abwe Prosem Abuse Seroes
AY Dus 112 Ves Yes vex
0w Ne
AY Ow 444 No Yes No
a Fage

This slide displays the Health and Substance Abuse Domains page of the report.
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Run Partner Report Template

Exporting a PDF will prompt to save the output file

Run Partner Report
[ output To B X
o\ J= H - Computer + OS (C3) ~ Users ~ OAC1 = My Videos ~ &3 [search My viceos L2}
View Partner Report - Reerteaean i
Search by ID T rp—
3 Report_MH_0_pr Mo items match your search.
+ @ Downioads
% fr Favorites
Export PDF Report - i
8 0 My Doamens
Search by ID I My Music
= My Pictures
i saved Games
% | Searches
™
® b Windows
| vC_RED.cab =
File name; [ Partner_Level Report.pdf =
Save as type: [FOF Format (*.pdf) =
™ Autostart
= et Tk - _Cnea |
4

The Export PDF Report — Search by ID button will export a PDF file of a partnership report
to a desired location on your network. There are two options for identifying the partnership
for the report. You can enter a CSI number in the first pop-up window or enter a Global ID
in the second pop-up window.

To export a report for a specific partnership, click on the Export PDF Report — Search by ID
button under the “Run Partner Report” heading.

As seen in this slide, an “Output To” window will appear which is used to designate a
location and file name for the report. The default name of the report,
“Partner_Level_Report”, can be changed. Use the navigation pane on the left-hand side of
the window to select a folder to which the PDF report will be saved. Select the Autostart
checkbox if you would like the report to be opened automatically when the export and save
process is complete. Then click OK. Selecting Cancel will return you to the front page
without exporting the report.

After the partner ID search criteria are entered, the PDF file will be generated and the file

will be saved in the selected location. If the Autostart checkbox was marked, a copy of the
report will open in a PDF viewing application.
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This Section Covers:

o Scope of Application Notes

o Overview of Application Notes Reports

> Overview of Application Notes Document
Appendices

o Importing Date and Timeframe Dimension Tables

o Steps to Create Application Note #1 in Access

This section provides an overview of the Application Notes document and appendices, and
it covers the detailed steps to create the Application Note #1 report in Microsoft Access.
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| Application

Download the
Appllcatlon Notes Full Service Partnership (FSP)
document from Data Collection & Reporting (DCR)

Data Extract Analysis Traini
ITWS and follow - £
. t t. f Training Slides and Presenter’s Notes for
1nstructions ror Analyzing Data and Creating Reports from DCR
creating new reports. Data Extracts

The BOWing COCUMENE WS AUnGed Dy the Mentsl Heslth Services Oversigrt snd
Accountability Commizsion.

The Application Notes provide instruction for using Microsoft Access and/or Microsoft
Excel applications to analyze the Full Service Partnership (FSP) DCR CSV data downloads.
These instructions provide two examples for analyzing the DCR CSV files to create reports
for partners’ length of service by provider. In the first Application Note, instructions are
provided for creating a report which identifies the average length of service for partners by
program and provider. This report also identifies the percent of quarterly (3M) assessments
which were completed for the partners. The second Application Note provides instruction
to create a report for the average length of service for partners based on reason of
discontinuation from partnership.

In January 2012, County Data Quality Reports were provided for each county/region based
on the data reported to the FSP DCR. The purpose of the County Data Quality Report was
to describe all of each county’s data and to identify inconsistent or outlying data points.
Counties participated in a survey rating the utility of the section of the reports. The
Application Notes are constructed for the report sections which received the highest score
based on the results of the survey and provide instruction to reproduce two of the sub-
reports from the Data Quality Reports by utilizing the county’s downloaded FSP DCR data
files at any point in time.
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Application Note #1 Report

FSP, Youth

No 3 732 913
Yas 2 885 957
Yes 1 mn 0
Yes 7 sss 788
No 3 72 313
Yes 0 707 916
FSP, Transitional
Ne 3 500 &
Yes as 249 613
No 3 500 &
~ Yes 45 249 513
FSP, Adults & Older Adult
No 2 1062 45
Yes 30 140 27
Ne 1 7 75
& 3N 1118 ]
™ 209 884 154
No 1 1088 0
Yes 32 1134 29
Ne e sg7
es 69 78
s 1 ue
No EH ses
Yes 373 945
FSP, WRAP
114 813 g
a4 636
e 158 763 €

Application Note #1 explains how to create the report "Average Length of Enrollment and
3Ms Completed for Partnerships Ever Served by Program / Provider" (similar to Section 2.2
in the Data Quality Reports). An example of this report can be seen in this slide. The report
summarizes the number of continuous or discontinuous partners, the average length of

partnerships and percent of 3Ms completed by provider and by program.
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Application Note #2 Reports

of or Each Program / Provider
FSP,| Proie Locktes. atuson Do |l
Family Tage  Mmngie  Paaa M owa  wetGam Decaased

Tage Semiogii Paad  Ndlofed MOwd MelGma maitsion Dacotus Diamd S

FSP,TAY.
crtvea

FSP,WRAP. wzmn—-m-—mﬂ-mmn-

F8P, Transitional Adult

Application Note #2 explains how to make two related reports: the "Number of
Partnerships by Discontinued Reason for Each Program / Provider" (similar to Section 2.7 in
the Data Quality Reports) and the “Average Length (Days) in Partnership by Program /
Provider and Discontinued Reason" (similar to Section 2.8 in the Data Quality Reports). An

example of these reports can be seen in this slide and the next slide.

The first report summarizes the number of partnerships by discontinue reason for each

provider and program.
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Application Note #2 Reports
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The second report summarizes the average length of partnership by discontinue reason for
each provider and program.
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Before Creating a New Report

* Load DCR CSV files into PLD Templates
¢ Print the Worksheet from Appendix D

* Import Tables from Appendix A and B:
Import the Table of Timeframe as CODES_TIMEFRAME
> Import the Table of Dates as CODES_DATES (optional)

I iF | | Attachments [
7 =R & @
[(Name = ! Descriptioé

;L‘Q_]CODES_DATESJI;
| B CODES_TIMEFRAME.xls

©

Ny

It is often desired to separate data into length timeframes or into date ranges when
creating reports. One way to quickly define partnership timeframes (e.g., number of
guarters a partnership has completed) or date ranges (e.g., fiscal years) is to create a table
with definitions of the several combinations of groupings which may be required
depending on the purpose of the report.

Reference: Kimball, Ralph; Ross, Margy. (2002). The Data Warehouse Toolkit: The Complete
Guide to Dimensional Modeling, Second Edition. New York: Wiley Computer Publishing.

Before starting, load the four DCR CSV files into the PLD Templates. Import the tables from
Appendix A (required) and Appendix B (optional) of the Application Notes document into
the database and name them as noted in this slide. As seen in this slide, the data tables can
be accessed by selecting the paperclip icon in the PDF Application Notes document and
double clicking on the file.
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Print Worksheet in A dix D
Appendix D: Query Record Count Worksheet
Note #1

Query Name Description Record Count
AP1_S01_001 Discontinuous Partnerships discontinued and reestablished
AP1_S02 001 3MsCompleted Partnerships with at least one or mare 3Ms
AP1_S03_001_D: i Total number of i
AP1 504 001 Variables_ByPartner Total number of partnerships
AP1_S05_001,_Totals_ByProvider Total number of providers by program by continuous partnership status
AP1_S05_002_Totals_ByProgram Total number of programs by continuous partnership status

One record for all d d for all
AP1_S05_003_Totals_System entire system
AP1_S05_004_Totals ALL Combination of providers, programs and system queries
Application Note #2
Query Name ipti Record Count
AP2_S01_001_Discontinuous Number of partnerships discontinued and reestablished
AP2_S03_001_Daysinservice Total number of i
AP2_502_001_DiscMaxDate Number of partnerships currently discontinued
AP2_S02_002_{ :_CreatedLast Number of ips currently
AP2_S07_003_DiscReason_Last Number of i iy
Al i Number of continuous partnerships

Number of continuous partnerships
AP2_S06_001_Variables_ByPartner Number of continuous partnerships
AP2_S07_001_Totals_ByProvider_n Total number of providers by program
AP2_S07_002_Totals_ByProgram_n Total number of programs
AP2_S07_003 _Totals_System_n One record for entire system
AP2_S07_004_Totals_All_n Combination of providers, programs and system queries
AP2_S08_001_Totals_BvProvider_Length Total number of providers by program
AP2_S08_002_Totals_ByProgram_Length Total number of programs
AP2_508_003 Totals_System_Length One record for entire system
AP2_S08_004 Totals_All_Length Combination of providers, programs and system queries
FSP Partner-Level Data Templates User Manual Page 82

Appendix D contains a helpful worksheet to use while tracking and validating the number
of records in each query while creating the reports.
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Before Creating a New Report

® Timeframe Dimension table:

[

A

& wn e o

B

o
0.032854209
0.065708419
0.098562628
0.131416838
0.164271047

C

D

0
0.010851403
0.021902806
0.032854209
0.043805613
0.054757016

E

F

1

G

DAYS_IN_SERVICE MONTHS_COMPLETED_EXACT MONTHS_COMPLETED_INT QRTS_COMPLETED_EXACT QRTS_COMPLETED_INT QRT_CURRENT YEARS_COMPLETED_EXACT

0
0.002737851
0.005475702
0.008213552
0.010951403
0.013689254

wlolulelolawnisl |

0.016427105
0.019164956
0.021902806
0.024640657
0.027378508
0.030116359

0.197125257
0.229979466
0.262833676
0.295687885
0.3285420%4
0.361396304

0.065708419
0.076659822
0.087611225
0.098562628
0.109514031
0.120465435

H
S

FSwwwauw

coooocooocoooooo

coooocooooo0oeo

L g T R T

H
(]

The Microsoft Excel file displayed in this slide defines the following groupings of
partnership length timeframes based on the number of days in partnership service. Import
this file as a new table in a Microsoft Access database to assist in aggregating and
summarizing data based on the length of service for a partnership.

Timeframes Defined based on Days in Service

. Months — Exact Fraction Completed

. Months — Rounded to Total Completed

. Quarters — Exact Fraction Completed

. Quarters — Rounded to Total Completed

. Years — Exact Fraction Completed

. Years — Rounded to Total Completed

. Timeframe — Three-Month Labels (e.g, “3Months”, “6Months”, etc.)

. Timeframe Categories — Simple grouping example based on Timeframe field
. 3Ms Due — The number of 3Ms which would be due based on the number of days in
service

OO NOOTULL B WNBRE
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Before Creating a New Report

» Dates Dimension Table

A 8 C D E B G H 1 J

1 DATE_VALUE MONTH_NO MONTH NAME DAY_OF MONTH YEAR_NO MONTH AND DAY DAY OF WEEK NO DAY OF WEEK NAME WEEKEND OR_WEEKDAY FY

8674 9/29/2008 9 Sep 29 2008 9/29 2 Mon Weekday 2008/2009
8675  9/30/2008 9 Sep 30 2008 9/30 3 Tue Weekday 2008/2009
8676 10/1/2008 10 Oct 1 2008 10/1 4 Wed Weekday 2008/2009
8677 10/2/2008 10 Oct 2 2008 10/2 5 Thu Weekday 2008/2009
8678  10/3/2008 10 Oct 3 2008 10/3 6 Fri Weekday 2008/2009
8679  10/4/2008 10 Oct 4 2008 10/4 7 sat weekend 2008/2009
8680  10/5/2008 10 Oct 5 2008 10/5 1 sun weekend 2008/2009
8681  10/6/2008 10 Oct 6 2008 10/6 2 Mon Weekday 2008/2009
8682  10/7/2008 10 Oct 7 2008 10/7 3 Tue Weekday 2008/2009
8683 10/8/2008 10 Oct 8 2008 10/8 4 Wed Weekday 2008/2009
8684 10/9/2008 10 Oct 9 2008 10/9 5 Thu Weekday 2008/2009
8685  10/10/2008 10 Oct 10 2008 10/10 6 Fri Weekday 2008/2009
8686  10/11/2008 10 Oct 1 2008 10/11 7 sat weekend 2008/2009

The Microsoft Excel file displayed in this slide defines the following groupings of dates.
Import this file as a new table in a Microsoft Access database to assist in aggregating and
summarizing data based on any date field in the FSP DCR data.

Date Groupings Defined

. Month Number — Month Number in Year (1 to 12)

. Month Name — Name of Month (Jan — Dec)

. Day of Month — (1 to 31)

. Year Number — Four digit year (1984 to 2024)

. Month and Day — Formatted as Month/Day (1/1 to 12/31)

. Day of Week — Weekday Number Starting on Sunday (1 to 7)

. Weekend or Weekday — Flag for Weekend or Weekday (Weekend, Weekday)
. Fiscal Year (FY) — Fiscal Year Formatted as Year/Year (1984/1985 to 2024/2025)
. Calendar Year (CY) Quarter (QRT) — (1 to 4)

10. FY Qrt— (1 to 4)

11. CY and QRT — Formatted as Year_Q# (1985 _Q1 to 2024_Q4)

12. FY and QRT — Formatted as FY_Q# (1984/1985_Q3 to 2024/2025_Q2)

OO NOOULL B WNPRE
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Import Excel File to Access DB
* From the PLD Templates:

5 Select External Data Menu

- Select Excel Button

“ Home Create I External Data I Database Tools Acrobat

D‘i‘j ﬁj =3 I_::'ij} 7] Text File :n:‘\_\l =z I == === s (A Access 2l
ay L 97 Gawne 27 SE SO S8 3 B
Saved 3 Excel ccess ODBC Saved Excel Text XML PDF  E-mail - Manage

Imports M Database K More * | Exports File  File orXpS &g More ~ Replies
Import & Link Export Collect Data

After saving the Timeframe and Date Dimension tables to a location on your network, open
the PLD Templates and select the External Data menu item and then the Excel button to
begin the import process.
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Import Excel File to Access DB

Get External Data - Excel Spreadsheet i d 3

Select the source and destination of the data

Spedify the source of the data.

Specify how and where you want to store the data in the current database.

' Import the source data into a new table in the current database.
lfhspedﬁedt&kdoesmlexst,mswlmmt If the specified table weadymls Access might ovenwrite its contents
with the i made to the source data will not be refiected in the database.

" Append a copy of the records to the table: [ es_Tbl =l

If the spedified table exists, Access will add the records to . If the table does not exist, Access will create it. Changes made
to the source data will not be reflected in the database.

" Link to the data source by creating a linked table.

Access will create a table that will maintain a link to the source d: de to the source d: cel will be
reflected in the linked table. However, hmdﬂhm-otbedwdﬁwmkm

Select Browse to locate the Excel file. Select to Import the source data into a new table in
the current database. Select OK.
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Import Excel File to Access DB

"8 import Spreadsheet Wizard 3

Your spreadsheet fle contains more than one or range.

@ stontioiorees [ — |

€ Show Named Ranges l

or range would you like?

Sample data for worksheat 'Values',
1 PAYS IN SERVICE MONTHS COMPLETED EXACT MONTHS COMPLETED_ INT QRTS COMPLETED EXACT DRTS ﬂ
P.000 P p.0oo0 ]
.033 o p.o11 <]
p.066 P p.o22 ]
P.099 P p.033 P
p.131 o p.044 P
.164 P p.0ss P
P.197 P P.066 p
.230 pP.077 ]
.263 P p.ose ]
.296 p.0o99 ]
22p0 b.32s b b.110 P
1 .361 b h.120 P
1sji2 .394 P p.131 P |+
1 | o
Cancel Next> s |

Select the worksheet, and select Next.
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Import Excel File to Access DB

3] Import Spreadsheet Wizard

Microsoft Access can use your column headings as field names for your table, Does the first
row spedfied contain column headings?

I [+ FirstRow Contains Column Headings | I

E

DAYS IN SERVICE [MONTHS COMPLETED EXACT |MONTHS COMPLETED INT [QRTS COMPLETED EXACT |QRTS
1 000 b.000 ﬂ
2h .033 b.o11
3 .066 b.o22 b
4 .098 b.o33
51 .131 P.044
65 .164 P.0ss
7 .197 b.oss b
g .230 b.o77
92 .263 p.oss
10 .296 p.oss
11j10 .329 b.110 P
12p1 .361 p.120
13h2 394 b.131
1af13 427 b.142 |
Kl I
| Cancel < Back Next > Einish

Check the First Row Contains Column Headings, and select Next. Select Next again on the

next screen.
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1\_——%7—_—,7_;
In \port Excel File to Access DB
3] Import Spreadsheet Wizard x4

| e Microsoft Access recommends that you define a primary key for your new table. A primary key is used to
= uniquely identify each record in your table. It allows you to retrieve data more quicky.
1 oo e

| P
3 :
2 oo (" Let Access add primary key.
== =  Choose my own primary key. [DAYS_IN_SERVICE |

€ No primary key,

DAYS IN SERVICE |[MONTHS COMPLETED EXACT |[MONTHS COMPLETED INT |[QRTS CCMPLETED EXACT [QRTS
.000 3 b.000 o i'
; b b.o11 o

b b.022 o

b b.033

b b.044

p p.0ss sl

4] p.066

P p.077

D p.ose

P p.ose

b b.110

b b.120

P b.131

b b.142 b |+

2|

Cancel <pack Next > s |

Select to Choose my own primary key and select the field DAYS_IN_SERVICE from the
drop-down menu. Select Next.
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Import Excel File to Access DB

2] Import Spreadsheet Wizard =

_ | Thats al the information the wizard needs to import your data.

Import to Table:
[cooes_Tmerramel

I™ Iwould like a wizard to analyze my table after importing the data.

In the Import to Table box, type the table name: CODES_TIMEFRAME or CODES_DATES for
the appropriate file. Select Finish. The table is now imported into the PLD templates.
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/ -

Working in Microsoft Access

* Beginning users can reference Chapter 1 for review of:

Types of Queries Used:
» Select Query

» Total Query

» Crosstab Query

» Union Query

Joining Tables and Sub-Queries
» Inner Join
» QOuter Join

Adding Criteria to the Query Definition

- Renaming Fields
Defining New Formulas in the Query Definition
Query View Options

The step-by-step instructions in these Application Notes are designed as a simplified
modular approach to utilizing Microsoft Access for beginning users.

The step-by-step instructions for the Application Notes assume the users have some basic
knowledge of Microsoft Access.

These topics will be covered during the process of creating the reports in this presentation.
Refer to the Application Notes (completed 4/5/2012) at Chapter 1 and section “Working in
Microsoft Access” on page 8 as a concise reference for these topics.

Page 87 of 128



FSP DCR Data Analysis Training

| Steps to Create App. No
Report:

1. Create a list of partners who have been discontinued and
reestablished using KET status

]

Count the number of 3Ms completed for each partner

Calculate the length in service for each partner

N

4. Combine lists and create additional variables by partner

5. Calculate Totals
- Total across providers
- Total across programs
- Total across county/system wide
- Perform a union query to combine all totals queries

6. Create a report using the MS Access Report Wizard

Once the Microsoft Access database contains the building blocks described previously in
this section, the report can be constructed through the six steps listed in this slide.
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SQL to Support Queries

* Appendix C of Application Notes .
document contains the code in support ||
of all queries we are about to create i

=

{ Datasheet View

J‘ PivotTable View

* Copying and pasting SQL code from
Appendix C into the SQL View window
can quickly recreate the queries i i

SQL 5QL View

|_L:‘_(‘ Design View

Appendix C from the Application Notes document provides the Microsoft Access SQL code
for all of the queries created in the Application Notes. The SQL code assumes the user is
utilizing the PLD Templates database offered by the MHSOAC. This code also assumes the
user has imported the CODES_TIMEFRAME (from Appendix A) and the CODES_DATES (from
Appendix B) tables into the PLD Templates.

Copying and pasting this code into the SQL view of an empty Microsoft Access query within
the PLD Templates will quickly recreate the queries designed in these Application Notes.

This code is provided for user convenience in testing and troubleshooting or recreating the
design of the queries.
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| Step 1: Create Listof
Reestablished Partners

ProviderSitelD
DateProgmChange
ProgramDesc
DatePsCIDChange
CoordinatorlD
DateKETStatusChange
PartnershipStatus

Code
DatePartnershipStatusChange / L~
KETStatus

DiscontReason
AB2034ChangeDate
AB2034
GHIChangeDate
GHI

Field: | GlobaliD =| kETstatus Description Continuous: : "No~
Table: | DCR_KETs DCR_KETs Codes_KetStatus

Sort:
Show: =] 1%} =] =] a
Criteria: x

or

The first step for this report is to create a list of all of the partners who were discontinued
and reestablished for the same partnership. These partners will be counted as “No” in the
Continuously Enrolled? column of the report. Partners not included in this list will be
counted as “Yes” for that column.

1. With the PLD Templates open in Microsoft Access, select Create > Query Design.

2. In the Show Tables pop-up window, select and add the following two tables to the
qguery: DCR_KETs, Codes_KetStatus. Then select the Close button.

3. As seen in this slide, select the [KETStatus] field within the DCR_KETs table, and drag and
drop the field onto the [Code] field of the Codes_KetStatus table to create an inner join
between the tables.

4. As seen in this slide, add the DCR_KETS.[GloballD], DCR_KETS.[KETStatus],
Codes_KetStatus.[Description] fields to the query definition spreadsheet.

5. As seen in this slide, create a fourth variable by typing the following into a blank column
of the query design: Continuous: “No”. This will create a variable in the query named

[Continuous] and assign the value “No” to all records.

6. As seen in this slide, add the criteria of “1” to the [KETStatus] field of the query. This will
limit the criteria to pull back only those records in which a partnership was reestablished.
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| Step 1: Create Listof S
Reestablished Partners
* In the SQL View, add the word Distinct to the query

SELECT [e)&3(¥[®) DCR_KETs.GloballD, DCR_KETs.KETStatus, Codes_KetStatus.Description, "No™ AS Continuous
FROM Codes_KetStatus INNER JOIN DCR_KETs ON Codes_KetStatus.Code = DCR_KETs.KETStatus
WHERE (((DCR_KETs.KETStatus)="1");

Running the query now will bring back all KET records for a reestablishment activity. A
partnership may have been discontinued and reestablished multiple times. However, we
only want a list of unique partnership identifiers for partnerships with any reestablishment
activity, regardless of how many times it occurred. Therefore, to remove duplicates, we will
choose to select distinct records.

As seen in this slide, move to the SQL View and insert the word DISTINCT after the word
SELECT. This will remove any duplicate rows from our query, resulting in one record per
[GloballD] with a [KETStatus] equal to “1”.
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| Step 1: Create Lis
Reestablished Partners

* Inspect the Query
» Write down the number of records on worksheet

® SaVe the query aS GlobaliD ~ | KETStatus - | Description - | Continuous -
AP]_ SO]_ 001 000026d9-02d4-43c4-8cea-foc0 1 Reestablished No
e e R 003acbd3-c8b5-4a48-b2a3-bfo« 1 Reestablished No
Di . 003b079b-4187-4290-a1a7-509. 1 Reestablished No
Scontlnuous 0041866b-ce51-41e0-bfd6-6691 1 Reestablished No
0048ae1d-8465-4654-9ee6-f7e 1 Reestablished No
00507b13-c3f0-449d-9f4a-f89%a: 1 Reestablished No
005462e2-f24f-4d85-b15f-1af1! 1 Reestablished No
0069add3-7072-4f5a-a56b-5ae’ 1 Reestablished No
00952c94-b507-47ef-b849-859t 1 Reestablished No
00c3e5f9-017c-4a2d-9576-1166 1 Reestablished No
00ee975b-6436-48b3-aede-c1€ 1 Reestablished No
0118ee70-dd7a-40c4-b223-0fd 1 Reestablished No
014c0569-1317-437d-9cb0-6ea: 1 Reestablished No
019a20c3-a855-4888-8556-2c13 1 Reestablished No

As seen in this slide, move to the datasheet view to inspect the results of the query. Write
down the number of records (i.e., partnerships ever discontinued and reestablished) on the
worksheet from Appendix D of the Application Notes document as reference. Save the
query as AP1_S01_001_Discontinuous.
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=

e el

e ——, %
- -Step 2: Calculate Number of 3Ms
Complete by Partner == .

AssessmentGUID

CountylD
CSINumber
GloballD
CountyFSPID

* Show the number of 3Ms
submitted for all partners
with at least one 3M

Name
PartnershipDate
Assessmen tDate
DateOtBirth
CSIDateOfBirth
Gender
Ethnicty A
Ethnicty B

|

[

|

|
Ethnicity
Racel

Race2

e If a partner has never had a
3M submitted, then the
partner will not exist in the
results of this query

Table: | DCR_3M DCR_3M
Total: | Group By Count
Sort:
Show:
Criteria:
or

Change

-

Step 2 involves calculating the number of 3Ms ever submitted for each partner. If a partner
has never had a 3M submitted, then the partner will not exist in the results of this query.
This query will show the number of 3Ms submitted for all partners with at least one 3M.

1. With the PLD Templates open in Microsoft Access, select Create > Query Design.

2. In the Show Tables pop-up window, select and add the following table to the query:
DCR_3M table. Then select the Close button.

3. Right click in the query definition datasheet in the bottom half of the window and
choose to add a Total row to the query definition.

4. As seen in this slide, add the [GloballD] and choose Group By from the drop-down
selections in the Total row.

5. As seen in this slide, add the [AssessmentDate] field to the query. Select the Count
operator from the Total row drop-down box. Rename the field by typing 3Ms_Completed:
in front of the original field name.
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:__,;;,-:::'-""':'-7 e L 77_.77_‘—__\—‘_‘:7—7 —
L -Step 2: Calculate Number of 3Ms

Complete by Partner
GloballD ~ 3Ms_Completed ~
® Inspect the results of 000026d9-02d4-48¢4-8cea-! 5
the query 00023a56-3478-411c-9b37- 8
000332a0-b752-43e2-2284- 4
00036466-5344-48c9-a2ba-} 2
e Write down the 0005d5d1-f5a6-478-9efa-a 5
00063f91-73bb-470f-9997-2 6
number of records 000d82a2-0ffc-40f0-8cda-8¢ 2
000ec902-acad-4e87-8104- 1
0013afb6-53e5-4721-8e26-¢ 1
* Save the query as 0017532f-04d5-47ae-a7b4-1 11
AP1 So2 oo1 001e3d28-57af-4326-9005-¢ 2
7 T o 001e9e18-1351-47b0-807f-" 12
3MSC0mP16tEd 001efb0d-d731-431f-9aed-* 7
002220ed-04f8-48ca-9746-C 12

As seen in this slide, move to the datasheet view to inspect the results of the query. Write
down the number of records (i.e., partnerships with at least one or more 3Ms) on the
worksheet from Appendix D of the Application Notes document as reference. Save the
guery as AP1_S02_001_3MsCompleted.
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e e —._ 7%&;_7 =
--Step 3: Calculate Length in Program

by Partner

[ DCR_PAFnonRes

AssessmentGUID

CountylD

CSINumber

GloballD

CountyFSPID e = =
Name DateDataDownload
PartnershipDate )

AssessmentDate DateDownload
DateOfBirth

CSIDateOfBirth

ProgramDesc
CoordinatorD
| PartnershipStatus

Field: | GloballD ProgramDes; ProvidersitelD P Dat
Table: |DCR_PAFnonRes  DCR_PAFnonRes  DCR PAFnonRes  DCR_PAFnONRes

End_Date: I (€ D DateDiff(d" [Partne

Show: B ] ) =
Criteria:
or

Step 3 involves calculating the number of days a partnership existed. Some partnerships
may have been discontinued, and some may still be active. Therefore, for active
partnerships, you will need to identify an end date for the calculation. The end date is
usually determined as the end date defined when the CSV files was extracted from the FSP
DCR.. The extraction is a static snapshot of all of the partnerships up to the date of
extraction.

1. With the PLD Templates open in Microsoft Access, select Create > Query Design.

2. In the Show Tables pop-up window, select and add the following tables to the query:
DCR_PAFnonRes and the DateDataDownload table. Then select the Close button. Do not
join the tables.

3. As seen in this slide, select and add the following fields to add to the query:
DCR_PAFnonRes.[GloballD], DCR_PAFnonRes.[ProgramDesc],
DCR_PAFnonRes.[ProviderSitelD], DCR_PAFnonRes.[PartnershipDate].

4. If the DCR_PAFnonRes.[PartnershipStatus] = 0, then the partnership is currently
discontinued, and the date the partnership was discontinued is stored in the
DCR_PAFnonRes.[DatePartnershipStatusChange] field. Otherwise, the partnership is
active, and the end date defined when the CSV files was extracted should be used to
calculate the length of partnership. As seen in this slide, select an empty column of the
guery definition datasheet, and enter the following formula to identify the correct end date
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to use when calculating the length of partnership.
End_Date: lIf([PartnershipStatus]=0, [DatePartnershipStatusChange],
[DateDataDownload].[DateDownload])

5. Now, calculate the length the partnership was in service by counting the number of days
between the partnership start date and the end date. As seen in this slide, select an empty
column of the query definition datasheet, and enter the following formula to calculate the
number of days the partnership existed.

DaysInService: DateDiff("d",[PartnershipDate],[End_Date])

Note: DateDiff is a MS Access function which helps calculate the difference between two
dates. The function takes three parameters. The first parameter, “d”, defines the calculation
should return the number of days. The second parameter is the start date for the calculation,
and the third parameter is the end date for the calculation.
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| Step 3: Calculate Leng
Program by Partner

e Inspect the results of the query
* Write down the number of records
* Save the query as AP1_So03_oo1_DaysInService

Glohallb « ProgramDesc -~ Pr&dersnelo ~ | PartnershipDate - End_Date - DaysinService -
074f58f7-9aa0-498¢c TAY FSP 1234 11/2/2010 1/15/2012 439
0b9cf2cb-c724-41ck Wraparound 1234 4/7/2009 8/18/2010 498
0ecb79a5-1190-4b6 Wraparound 1234 6/7/2007 6/20/2008 379
0f3e5f66-89ef-4657 Adult FSP 1234 12/3/2010 1/15/2012 408
115a7401-4320-48¢t Adult FSP 1234 7/8/2008 1/15/2012 1286
15d2873f-0591-4db TAY FSP 1234 3/12/2008 11/20/2008 253
19cb7956-3373-48d Adult FSP 1234 12/17/2008 2/10/2010 420
1a312cba-37e5-4e2 Wraparound 1234 1/11/2011 1/15/2012 369
1bSeaee0-9b4d-45! Wraparound 1234 9/1/2006 1/17/2008 503
1b9¢ce01c-8d75-4ee Wraparound 1234 6/15/2009 1/15/2012 944
1d554b0d-e177-4bt Wraparound 1234 6/13/2007 9/15/2007 94
1f32bb6c-add9-4d2 Older Adult FSP 1234 10/13/2009 1/15/2012 824
2353a1d1-35f9-492; Wraparound 1234 5/18/2011 1/15/2012 242

Move to the datasheet view to inspect the results of the query. Write down the number of
records (i.e., total number of partnerships) on the worksheet from Appendix D of the
Application Notes document as reference.

Save the query as AP1_S03_001_DayslInService.
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.-{/_/_" _;;F
- = e = =
— s T+¥ - —
Step 4: Combine All Var abj?S,b}‘é
 AP1_502.001_3MsCompleted |
e  AP1_s01_001_biscontinuous
GloballD [ AP1_S03_001_Daysinservice | ;:; =
3Ms_Completed * oha
GloballD KETStatus
ProgramDesc Description
ProviderSitelD Continuous
PartnershipDate
End_Date
- DaysInService
CODES_DATES /
. | CODES_TIMEFRAME
¥ DATE_VALUE ‘ ¥
MONTH_NO ¥ DAYS_IN_SERVICE
MONTH_NAME MONTHS_COMPLETED_EXACT
DAY_OF_MONTH MONTHS_COMPLETED_INT
YEAR_NO QRTS_COMPLETED_EXACT
MONTH_AND_DAY QRTS_COMPLETED_INT
DAY_OF_WEEK_NO QRT_CURRENT
DAY_OF_WEEK_NAME YEARS_COMPLETED_EXACT
WEEKEND_OR_WEEKDAY YEARS_COMPLETED_INT
Y = TIME_FRAME
CY_QRT TIME_CAT_6MOS
FY_QRT - TIME_CAT_3MOS
CY_AND_QRT 3MS_DUE
FY_AND_QRT

Step 4 involves joining information from all of the previously created queries. This query
will result in one record per partner.

1. With the PLD Templates open in Microsoft Access, select Create > Query Design.

2. In the Show Tables pop-up window, select and add the following two tables from the
Tables tab: CODES_TIMEFRAME, CODES_DATES. Select the Queries tab and add the
following three queries: AP1_S03_001_DayslnService, AP1_S02_001_3MsCompleted,
AP1_S01_001_Discontinuous. Then select the Close button.

3. As seen in this slide, create the following joins between the five tables/queries:

¢ Inner join between AP1_S03_001_DayslInService.[PartnershipDate] and
CODES_DATE.[DATE_VALUE]

¢ Inner join between AP1_S03_001_DaysInService. [DaysInService] and
CODES_TIMEFRAME.[DAYS_IN_SERVICE]

e Outer join from AP1_S03_001_DaysInService.[GloballD] to
AP1_S02_001_3MsCompleted.[GloballD]

e Outer join from AP1_S03_001_DaysInService.[GloballD] to
AP1_S01_001_Discontinuous.[GloballD]

After you have created a join on two fields, right click on the line indicating the join and
change it to an outer join (as indicated by a directional arrow) as needed.
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| Step 4: Combine Al Va
by Partner

* Add fields to query definition

* Enter formulas as new fields in query:
Continuous_Enrolled: IIf([Continuous] Is Not
Null,[Continuous],"Yes")

- 3Ms_Complete: IIf([3Ms_Completed] Is Not
Null,[3Ms_Completed],o0)

Field: |3MS_DUE 3Ms_Complete: If([BMs_Completed] Is Not Null, BMs_Completed),0) | Continuous_Enrolled: If([Continuous] Is Mot Null,{Continuous], Yes] | FY_Enrolled: FY
Table: | CODES_TIMEFRAME CODES_DATES
sort:
Show: 1] ] ]
Criteria:
on

4. Add all of the fields from the AP1_S03_001_DayslInService to the query definition.
5. Add the CODES_TIMEFRAME.[3MS_DUE] field.

Note: Optionally, add any other fields from the CODES_DATE table, such as [FY_AND_QRT]
(i.e., fiscal year and quarter) by which you may later want to aggregate the data.

6. Identify the partners who were not continuously enrolled, and set the remaining
partners to “Yes” for the [Continuous] field. Select an empty column of the query definition
datasheet, and enter the following formula to identify continuous or discontinuous
partnerships.

Continuous_Enrolled: lIf([Continuous] Is Not Null,[Continuous],"Yes")

7. Now, you will need to select the number of 3Ms completed, which was previously
calculated for partnerships with at least one 3M completed. However, some partners may
not have had a 3M completed, and a formula will need to set the value for this variable to
zero for these partnerships. Select an empty column of the query definition datasheet, and
enter the following formula to set the number of 3Ms completed for all partnerships.
3Ms_Complete: IIf([3Ms_Completed] Is Not Null,[3Ms_Completed],0)
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by Partner

e Inspect the results of the query
* Write down the number of records
 Save the query as AP1_So4 _oo1_Variables ByPartner

GloballD - DaysInService - PartnershipDate - | End_Date - ProgramDesc - ProviderSitelC - 3MS_DUE - 3Ms_Complete - Continuous -«
074f58f7-9aa0-498d 439 11/2/2010 1/15/2012 TAY FSP 1234 4 0 Yes
Ob3dcf2cb-c724-41cb- 498 4/7/2009 8/18/2010 Wraparound 1234 5 3 Yes
Oecb79a5-1190-4b6t 379 6/7/2007 6/20/2008 Wraparound 1234 4 4 Yes
0f3e5f66-89ef-4657- 408 12/3/2010 1/15/2012 Adult FSP 1234 4 3 Yes
115a7401-4320-48¢5 1286 7/8/2008 1/15/2012 Adult FSP 1234 14 12 Yes
15d2873f-0591-4dbc 253 3/12/2008  11/20/2008 TAY FSP 1234 2 2 Yes
19¢b7956-3373-48dC 420 12/17/2008 2/10/2010 Adult FSP 1234 4 4 Yes
1a312cba-37e5-4e2f 369 1/11/2011 1/15/2012 Wraparound 1234 a4 0 Yes
1bSeaee0-3bdd-45b 503 9/1/2006 1/17/2008 Wraparound 1234 5i 5 Yes
1b9ce01c-8d75-deer 944 6/15/2009 1/15/2012 Wraparound 1234 10 8 Yes
1d554b0d-e177-abb 94 6/13/2007 9/15/2007 Wraparound 1234 1 1 No
1f32bb6c-adds-4d2¢ 824 10/13/2009 1/15/2012 Older AdultFSP 1234 9 0 Yes
2353a1d1-359-4921 242 5/18/2011 1/15/2012 Wraparound 1234 2 1 Yes
23917306-2067-4b8¢ 915 7/14/2009 1/15/2012 TAY FSP 1234 10 7 Yes

Move to the datasheet view to inspect the results of the query. Write down the number of
records (i.e., total number of partnerships) on the worksheet from Appendix D of the
Application Notes document as reference. The number of records in this query should
match the number of records in the AP1_S03_001_DayslInService query.

Save the query as AP1_S04_001_Variables_ByPartner.
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| Step 5: Total by Provider,
Program and System

" APL_S04_001_Variables_ByPartner

GloballD
DaysinService
PartnershipDate
End_Date
ProgramDesc
ProvidersitelD
3MS_DUE
3Ms_Complete

FY_Qrt_Enrolled
QRT_CURRENT

Field: roviderSitelD c _Enrolled GloballD DaysinService 3MS_DUE 3Ms_Complete
Table: | AP1_S04_001_Variable APL_S04 001 _Variable APL_S04_001_Variable APL_S04_001_Variable AP1_S04_001_Variable: AP1_S04_001_Variable AP1_S04_001 Variable
Total: | Group By Group By Group By Count Sum Sum Sum
Sort: | Ascending Ascending Ascending
Show: = =] ]
Criteria:
or

Step 5 involves aggregating the data from step 4 into summaries by provider, program and
the entire system (i.e., county).

1. With the PLD Templates open in Microsoft Access, select Create > Query Design.

2. In the Show Tables pop-up window, select the Queries tab and then select and add the
guery from previous step: AP1_S04_001_Variables_ByPartner. Then select the Close
button.

3. Right click in the query definition spreadsheet, and add the Total row to the query
definition.

4. As seen in this slide, add the following variables, and select the following operator in the
Total row.

[ProgramDesc] Group By
[ProviderSitelD] Group By
[Continuous_Enrolled] Group By
[GloballD] Count
[DaysInService] Avg

[3Ms_Due] Sum
[3Ms_Complete] Sum
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| Step 5: Total by Provider,
Program and System

* Add fields to query definition

» Enter formulas as new fields in query

* Inspect the results of the query

* Write down the number of records

e Save the query as AP1_So5_oo1_Total_ByProvider

Programl - ProviderSite - |Continuous_ - | CountOfGloballD - | AvgOfDaysinService - |3Ms_Due_Sum ~ 3Ms_Comp_Surr - 3Ms_PctnComp_ByProvider -
1100,Senec: 1376790840 Yes 544 28 26 92.9
1100,Senec: 1447435906 No
1100,Senec: 1447439906 Yes
1100,Senec 1497061873 Yes
1100,5enec 1699924654 Yes
1100,Senec: 1730345760 Yes
1100,5enec: 1942430487 No
1100,Senec: 1942450487 Yes

702 7 7 100
536 11 11 100
198 4 4 100
461 5 4 80
575 17 14 824
536 6 4 66.7
161 1 1 100

oW NN R D

5. Now calculate the percent of 3Ms completed for all partnerships aggregated by each
combination of program, provider and continuously enrolled status. Select an empty
column of the query definition datasheet, and enter the following formula. In order to
avoid dividing by zero when no 3Ms are due for an aggregated group, this formula uses an
IIF statement in the formula to insert null values in the results for those cases.

3Ms_PctnComp_ByProvider: IIf(Sum(AP1_S04_001_Variables_ByPartner.[3MS_DUE])=0,
Null, Round(100*(Sum(AP1_S04_001_Variables_ByPartner.[3Ms_Complete])/
Sum(AP1_S04_001_Variables_ByPartner.[3MS_DUE])),1))

Select the Expression option in the drop-down box of the Total row.

6. As seen in this slide, move to the datasheet view to inspect the results of the query. The
guery should display one record for each combination of provider, program and continuous

or discontinuous partnership. Write down the number of records in the query.

7. Save the query as AP1_S05_001_Total_ByProvider.
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| Step 5: Total by Provider,
Program and System

(i1 s e * Copy the query just created and save as
i AP1_Sos5_ooz2_Total_ByProgram
i”‘?m ® Open in Design View
B iy * Replace the [ProviderSiteld] field
Eaer with;

g ProviderSitelD: “zz~ ALL

PROVIDERS ~zz”

Field: | ProgramDesc rovidersSitelD: “zz~ ALL PROVIDERS ~zz Continuous_Enrolled Glaballp
Table: |AP1_S04_001_Variable AP1_S04_001_Variables_ByPartner AP1_S04_001_Variable
Total: | Group By Group By Group By Count

Sort: | Ascending Ascending
Show:

8. Copy and paste the query just created, and name the new query
AP1_S05_002_Total_ByProgram.

9. Open the new query in Design View.

10. Now aggregate the data in this new query by all providers for each program. As seen in
this slide, replace the [ProviderSiteld] field in the second column of the query definition
with the following constant.

ProviderSitelD: “zz~ ALL PROVIDERS ~zz”

The z’s in the constant will help sort this summary row to the bottom of all other provider

values. Alternatively, a space before the term will sort the row to the top of all providers, if
there are no null provider values in your dataset.
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Program and System

* Inspect the results of the query
* Write down the number of records
* Save and close the query

ProgramDe - ProviderSitelD - Continuous_ - CountOfGloballD - AvgOfDAYSINSERVICE - SumOf3MS_DL - SumOf3Ms_Cor - 3Ms_PctnCom - |
3200,Citywide 22~ ALLPROVIDERS “22  Yes 169 a2 678 660 97.3
3300,SF First Il 2z ALLPROVIDERS *22  No 2 908 19 15 78.9
3300,SF First Il 2z~ ALLPROVIDERS ~z2  Yes 240 785 2007 1803 89.8
4000,FSA Olde 2z~ ALLPROVIDERS “2z  No 2 952 20 20 100
4000,FSA Olde 2z~ ALL PROVIDERS “~z2z Yes 95 567 557 473 84.9
45RH,Shasta R zz” ALLPROVIDERS 2z No 6 749 47 45 95.7
45RH,Shasta R 2z ALL PROVIDERS "2z Yes 3 496 173 126 72.8

11. As seen in this slide, move to the datasheet view to inspect the results of the query. The
query should display one record for each combination of program and discontinuous or
continuous partnership. Write down the number of records in the query as reference. Save
and close the query.
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| Step 5: Total by Provider,
Program and System

* Copy and paste query as

[ AP1_S04_001_Variables_ByPartner |
b | AP1_Sos_oo3_Total_System
oba
PatnenipDe * Open in Design View
End_Date
e » Replace the [ProgramDesc] field
o o with:
Eﬁ'n:;i‘ﬁiﬁ?_”l‘i:ii’.il""“ ProgramDesc: “zz~ ALL
Y_Enrolled
FY_Qrt_Enrolled PROGRAMS __,Zz”
QRT_CURRENT

Field: BRIl e raugP N le e A NI NE S0 ProviderSitelD: “zz~ ALL PROVIDERS Continuous_Enrolled GloballD
Table: AP1_S04_001_Variable AP1_S04_001_Variable
ACIELE Group By Group By Group By Count
bRl Ascending Ascending Ascending
Show:

Criteria:
or

12. Copy and paste the query just created, and name the new query
AP1_S05_003_Total_System.

13. Open the new query in Design View.
14. Now aggregate the data in this new query by the entire system of data. Replace the

[ProgramDesc] field in the first column of the query definition with the following constant.
ProgramDesc: “zz~ ALL PROGRAMS ~zz”

Page 105 of 128



FSP DCR Data Analysis Training

’Step 5 Total'bTProvide/
Program and System

* Inspect the results of the query
* Write down the number of records
* Save and close the query

ProgramDesc  ~ | ProviderSitelD -« |Continuous_Enrolle = | CountOfGlobaliD | AvgOfDAYSINSERVICE - 3Ms Due_Sum » 3Ms_Comp Sum - 3Ms_PctnComp «
zz* ALLPROGRAMS ~zz zz* ALL PROVIDERS No 2037 737 15777 9641 b].l
27* ALLPROGRAMS ~2z 2z ALL PROVIDERS Yes 45111 592 277987 156232 56.2

15. As seen in this slide, move to the datasheet view to inspect the results of the query.
This query will display one record for all continuous partnerships and one record for all
discontinuous partnerships in the entire system of data. Write down the number of records
in the query as reference. Save and close the query.
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| Step 5: Total by Provider,
Program and System

* Create Union Query
oSelect Create > Query Design
oSelect Close on Show Tables
oSelect View > SQL or Union

o Type:

SELECT * FROM AP1_Sos5_oo1_Total_ByProvider;
UNION

SELECT * FROM AP1_Sos5_oo2_Total_ByProgram;
UNION

SELECT * FROM AP1_Sos5_oo03_Total System;

16. Create one last query to combine the rows of the previous three queries in
Select Create > Query Design. Select the Close button in the Show Tables pop-
not add any tables to the query. Select the View > SQL or the Union option for

code to combine the rows in the previous three queries with a union.

SELECT * FROM AP1_S05_001_Total_ByProvider;
UNION

SELECT * FROM AP1_S05_002_Total_ByProgram;
UNION

SELECT * FROM AP1_S05_003_Total_System;
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Program and System

* Inspect the results of the query
* Write down the number of records
* Save query as AP1_So5_oo4_Total _ALL

ProgramDesc - ProviderSitelD - Continuous - | CountOiGlobaliD + | AvgOfDAYSINSERVICE - 3Ms_Due Sum + | 3Ms_Comp_Sum - | 3Ms_PctnComp_ByProvider -
: ) 1238 No i 17 2 1 5
Adult FSP 1234 Yes 61 438 310 202 65.2
adult Fsp 27 ALLPROVIDERS 22 No 1 173 2 1 50
AdultFsp 22 ALLPROVIDERS ~22 Yes 61 498 310 202 65.2
FSP 1234 Yes 1 1072 11 0 0
FSp 22~ ALLPROVIDERS ~21z Yes 1 1072 1 0 0
Older Adult Fsp 1234 Yes 3 834 36 3 35
Older Adult FsP 2z ALLPROVIDERS “2z Yes 3 834 86 3 35
TAYFSP 1234 No 3 931 30 bE] 76.7
TAYFSP 1238 Yes 33 671 21 78 33.8
TAY FSP 22 ALLPROVIDERS “22 No 3 931 0 2 76.7
TAY FSP 27 ALLPROVIDERS “22 Yes EY) 671 21 78 338
Wraparound 1234 No 1 94 1 1 100
Wraparound 1233 Yes 48 673 339 152 248
Wraparound 27 ALLPROVIDERS 22 No 1 94 1 1 100
Wraparound 2z* ALLPROVIDERS "2z Yes 48 673 339 152 448
27" ALLPROGRAMS ™1z 2z ALLPROVIDERS ~2z2 No 5 612 33 25 5.8
27 ALLPROGRAMS ~2z 2z” ALLPROVIDERS 22 Yes 152 618 977 435 a45

17. Move to the datasheet view to inspect the results of the query. The number of records
should equal the sum of records from the previous three queries created in this step.

18. Save the query as AP1_S05_004_Total_ALL.
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Step 6: Design Report

* Export last query to Excel or
* Create Access report

The last step in this process is to design the report. The final query,
AP1_S05_004_Total_ALL, holds all of the data for the final table. This query can be
exported into Microsoft Excel for formatting or into Microsoft Access to create a report
template.
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Step 6: Design Report - Excel

R- h 3 AP1_S01_001_Discontinuous
lg t mouse 3 APL_S02_001_3MsCompleted
l. =P APL_S03_001_Daysinservice

C ICI( On the 3 AP1_S04_001_Variables_ByPartner
31 APL_S05_001_Totals_ByProvider

API SOS 004 T3 AP1_S05_002_Totals_ByProgram
23 AP1_505_003 Totals_System

Total A_LL QD AP1_S05.004_Totals_All 5 lo

== T @ AP2_501_001_Discontinuous é ;::M,W__J
"3 AP2_502_001_DiscMaxDate ;pm & B
w3 AP2_S02_002_DiscMaxDate_CreatedLast R Collect and Update Data via E-mail } SharePoint List
3 AP2.502_003 DiscReason_Last P P— @ Word RTF File
3 AP2_503_001_DaysinService ﬂldel_nmlzsroup [ PDForXps
3 AP2_504_001_DaysInService_ExcIDisconti Dejete @) Access
P AP2_505 001 _DaysinService_DiscReason % cu > TextFile
#3) AP2_506_001_Variables_ByPartner @ 25;3 ®} XMLFile
B3 AP2_507_001_Totals_ByProvider_n @} ODBC Database
[ AP2_507_002_Totals_ByProgram_n & Object Properties @} HTMLDocument
] AP2_S07_003_Totals_System_n @ Check Web Compatibility | At e
QD AP2_507_004_Totals_Alln | 8y word Merge

1. With the PLD Templates open in Microsoft Access, right mouse click on the
AP1_S05_004_Total_ALL and choose Export > Excel, as seen in this slide.

2. Provide a file name and browse to a location to save the Excel file.

3. Select Export data with formatting and layout and select Open the destination file after
the export operation is complete. Click OK.

4. Your data is now in Microsoft Excel, and can be formatted for inclusion in a Microsoft
Word report.
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Step 6: Design Report - Access

[ Report Wizard
Create > ™=
Which fields do you want on your report?

Report You can choose from more than one table or query.
Wizard

Tables/Queries

|Query: AP1_505_004 Totals_Al |

Available Fields: Selected Fields:

ProgramDesc
ProviderSiteID
== | | Continuous_Enrolled
CountOfGloballD
AvgOfDAYSINSERVICE
3Ms_Due_Sum
3Ms_Comp_Sum

Cancel | Back Next > Finish

Alternatively, a report template can be created in Microsoft Access.

1. With the PLD Templates open in Microsoft Access, click once on the
AP1_S05_004_Total_ALL query to highlight the query. Choose Create > Report Wizard in
the report section of the menus. As seen in this slide, the selected query should show in
the wizard. If the desired query is not showing in the drop-down box, then select the drop-
down and locate the correct query.

2. As seen in this slide, select the >> button to move the entire set of fields into the
Selected Fields box. Click Next.
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Step 6: Design Report - Access

GI'OUP by Do you want to add any grouping T |-
| levels? ‘ |ProgramDesc l | |
[ProgramDesc] | |
| ProviderSiteID, Continuous_Enrolled,
| CountOfGlobalID, [ |
->—' IAvgOfDAYSINSERVICE, 3Ms_Due_Sum,
Continuous_Enrolled 3Ms_Comp_Sum,
CountOfGloballD il ‘ 3Ms_PctnComp_ByProvider
AvgOfDAYSINSERVICE
3Ms_Due_Sum | |
3Ms_Comp_Sum * [
3Ms_PctnComp_ByProvidet priority i
EZ] '
|
| |
|
|
= — |
| |
Grouping Options Cancel < Back Next > Finish | I
T J

3. As seen in this slide, select the [ProgramDesc] and then select the > button to group the
report sections by program. Select Next.
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Step 6: Design Report - Access
S T —

e - ~ | You can sort records by up to four fields, in either
ing or order.

. 1 IProwderSlteID =] | Ascendng I
2 |Conh'nuuus_EnroHed d Ascending I
4 I _-] Ascending

4. As seen in this slide, select to sort by [ProviderSitelD] and then [Continuous_Enrolled]
fields from the drop-down boxes. Click Next.
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Step 6: Design Report - Access
Block and mw@nwﬁ;;tff ~ —_m = {
Landscape | : = A

N2

apage.

5. As seen in this slide, select the Block layout and select the Landscape orientation. Click
Next.
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/

Step 6: Design Report - Access
Name the i____* Mtatﬁﬂedovouwmtfnrmreport?_ El _ _:
Report [AP1_s05_004_Totals_All_Rpt

That's all the information the wizard needs to create your
report.

Do you want to preview the report or modify the report's
design?

(= Preview the report.
" Modify the report's design.

6. As seen in this slide, name the report AP1_S05_004_Total_ALL_Rpt. Click Finish.
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Step 6: Design Report - Access

® Design View

| € nglambes.( Header ;
| # Detail
- ||iiiii|ProgramDesc :|ProviderSitelD |Continuous_Enrolled !CUU"lC;AVgOfDAVﬂNSERFMS_‘DUE_‘SUV’H |3Ms_Comp_Sum |3Ms_Pctr|
| € Page Footer
TSR ] e T “ i R ] : A

S ‘ ="Page " &[Page] & " of " & [Pagss]}

j ”:Now()
| € Report Footer

7. As seen in this slide, move to the Design View to change the design of the report. After
the wizard creates the report, the report format can be optimized by rearranging the
location of the fields.
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Step 6: Design Report - Access

» Resize, rename and relocate fields

- |Programbesc | [ [ [ ‘ [ |
# Detail

PRI |:3roand9r5xteid : Cnntanous_E:*rokked .(ounrOfGHnaI!D WS_JN_.SER\I:EE : : l Providar(’
& Page Footer

* || [=Now() i L R ="Page " & [Page] & " of " & [Pages]
# Report Footer

8. As seen in this slide you can resize, rename and relocate the fields and labels to match
the following design or another format as desired. The following steps provide a quick
overview of the steps required to change the report from the layout in the previous slide to
this slide.

e Click in the label in the Report Header section and rename the report title.

¢ Click on each of the labels in the Page Header section and rename each label to match
the new label titles in this slide.

¢ Hold the Shift key to simultaneously select all labels in the Page Header section, and
move the labels down in the section to make room for the report title label. Click and drag
to arrange each label in the Page Header section to match the layout in this slide.

¢ Drag and drop the report title from the Report Header section to the Page Header
section.

¢ Minimize the size of the Report Header section by clicking and dragging upward on the
lower section separator bar.

¢ Lengthen the ProgramDesc Header section by clicking and dragging downward on the
lower section separator bar.

¢ Drag the [ProgramDesc] field from the Detail section to the ProgramDesc Header
section.

e Select on the ProgramDesc Header bar and right-click and select Properties to display the
properties window on the right side of the screen. In the Format tab, select the Back Color
to be gray. Set the Alternate Back Color to be No Color.

¢ Select on the Detail bar, and in the Format tab of the Properties window, select the
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Alternate Back Color to be No Color.

e Select the [ProgramDesc] field and in the Properties window, set the Width to 4” and set
the Back Style to Transparent.

e Select each field in the Detail section and click and drag the left edges to resize the fields to
resemble this slide.

e Align the fields in the Detail section underneath the corresponding label from the Page
Header section.
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f' Step 6:

FSP, Youth
No 73 913
Yes 685 957
Yes m 0
Yes 285 788
No 32 913
Yes o7 91
FSP, Transitional
No 3 500 €0
Yes a5 249 613
~ ALLPROVIDERS ~ No 3 500 &0
~ ALL PROVIDER! Ys s 248 613
FSP, Adults & Older Adult
3622 No 2 1069 45
3622 Yes 30 1401 27
2688 No 1 m 75
Yes 32 1118 [
No 28 I 191
Yes 209 264 154
No 1 1088 0
ves 22 134 99
No 3 287 83
Ves &9 % 299
Yes 1 162 a3
No E 563 182
Yes 373 335 139
FSP, WRAP
36CH Ve 14 813 186
E Yes 44 635 14
LL PROVIDER! Yes 158 76 146

9. View the report in print preview.

. If formatted following the directions listed previously,

the report will resemble the example displayed in this slide. Adjust the orientation and

margins for printing as desired.
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Using Excel for Analysis

e

* Analyze one CSV file at a time
* Use formulas to create new fields
» Use Pivot Tables to aggregate data

* Has many limitations

A limited amount of analysis can be performed in Microsoft Excel alone. A single CSV file
can be imported, and Microsoft Excel’s pivot table can aggregate and summarize the
information. While Microsoft Excel does not have the functionality to create report
templates from the information in multiple CSV files, Microsoft Excel can calculate the
length in program, number of 3Ms due and completed, and percent of 3Ms complete for all
partners in a file. However, since the following analysis is from the 3M CSV file, a partner
must have had at least one 3M completed to exist in the file and be included in this
analysis. Partners without 3Ms would need to be identified separately from the PAF file.
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Using Excel for Analysis

o

* Open 3M file in Excel

* Create new fields

BR BS BT BU BV BW I BX BY BZ
AssessmentType Age_Group AssessmentSource CreatedDate QtrlyCntyUsel QtrlyCntyUse2 QtrlyCntyUse3 IDaisInSerch.thDue

M 1
m 1

1 5/27/201013:34 429

1 9/13/201011:27 429
M 11 1 9/13/201011:21 429
3m 11 1 10/11/201013:48 429
3m 2 1 8/4/201010:05 208
3m 2 1 7/28/2010 7:56 208
3m 1 1 8/9/201113:37 462
ELY) 8 1 9/10/20107:47 192

N VNN B BB S

1. Open the DCR 3M CSV file in Microsoft Excel.

2. As seen in this slide, select the first empty column of the spreadsheet (e.g., BY) and
create a new heading called DaysInService. In the cell below the heading, type in a formula
to calculate the number of days in service to the end date. Since Microsoft Excel uses cell
locations and not field names to perform calculations, the formula appears below with field
definitions and then as an actual example formula used in Microsoft Excel. The formula first
identifies if the partnership status is 0, signifying the partnership has ended, and in this
case calculates the days in service by subtracting the partnership date from the date the
partnership ended. Then in the cases in which the partnership has not ended, the days in
service are calculated by subtracting partnership date from the end date defined when the
CSV file was downloaded from the DCR.

Formula Definition: =IF([PartnershipStatus]=0, [DatePartnershipStatusChange]-
[PartnershipDate], “Date of Download”- [PartnershipDate])

Formula Example: =IF(U2=0,T2-G2,"10/6/2011"-G2)
3. As seen in this slide, copy and paste the formula down all of the rows of data.
4. As seen in this slide, select the next empty column of the spreadsheet (e.g., BZ) and

create a new heading called 3Ms Due. In the cell below the heading, type the formula
below to calculate the approximate amount of 3Ms due. The following formula divides the
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number of days in service by the number of days in a quarter (365.25/4 = the number of days
in a quarter) and returns the integer (INT) of completed quarters in service.

Formula Definition: =INT([DaysInService]/(365.25/4))
Formula Example: =INT(BY2/(365.25/4))
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* Insert Pivot Table on new worksheet
A I 8 C D 3 -‘ PivotTable Field List et )
1 Age_Group (all) - e
2 Choose Belds o add to repart: 2
3 [Row tabels ~average of Daysinservice Average of 3MsDue Count of AssessmentDate [ClAssessmentGlD |
4 000332a0-b752-43¢2-3284-8dcd60c3ebch 229 4 a DContyD
5 000d82a2-Dffc-40f0-Bcda-Scfe8208cbb2 208 2 2 CCeDkmrer i
 Globalip
6 0013afbe-53e5-4721-5e26-9a8032c4cc10 62 5 1 g
7 001e3d28-57af-2a26-9005-8adaeb57d72f 192 2 2 Cname
3_ 003acbd3-c8bs-4848-b2a3-bloasdash1ef 709 7 7 OPartnershiotate
9 |00483610-8465-4654-9e86-76344396¢78 529 5 3 [ AssessmentDate
10 00507013-¢3f0-449d-9f42-89acSces396 566 6 2 [OoateofBeth
11 006bc32b-8e0a-4182-bbed-bZbeb3cdsecd as7 5 5 CicsiDateofsrt
12 00700¢87-fBcb-4389-a60¢- Ce3616S1d37d 104 1 1 ) Gencer
13 00898385-e00e-4fbf-bdes-T21cicieedbld 434 4 5 DEthacty & %
14 0030e52a-14ab-4e50-9d1f-57c2a410ab36 2047 2 13 e =
15 009a3dcf-8822-4bBe-9dd3- 225082661076 132 1 1 Drag fekds betwreen areas below:
16 00ac7348-8649-40d1-adb4-d7113a159eda 507 5 4 W Report Fiter ] Column Labels
17 00aec7d1-c001-4883-b5b4-fdg6abe7793d 110 1 1 Age_Grow =] [ volues
18 00b03517-1d31-4741-3387-403765046036 n7 7 7
19 00c25fas-12af-43d7.8576- B8 1e68bcT2ed 50 a 4
20 00c7fcea-307e-4101-90f5- 28983387629 28 2 1
21 00cBfaed-65d1-4193-8915- 15107473519 3009 32 6 it e
22 00dGebdf-eds3-4d7E-a7a6-196e 1b5bT61a 182 1 2 sl T |
23 00dcdalb-909b-448c-9591-c224831efd01 139 12 10
24 00dde551-19bb-dbf9-bise- ficebdiass3d 187 2 1

5. Select anywhere within the data in the spreadsheet and choose to insert a pivot table
into a new worksheet by selecting Insert > Pivot Table from the menus. The data selection
will expand to the entire table of data within the spreadsheet.

6. This step will summarize the number of 3Ms completed and 3Ms due for each partner.
Add the field [Age_Group] to the Report Filter box. Add the field [GloballD] to the Row
Labels box. Add the [DaysInService] to the Values box and change the Value Field setting
to Average. Add the [3MsDue] to the Values box and change the Value Field setting to
Average. Add the [AssessmentDate] to the Values box and change the Value Field setting
to Count.
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Using Excel for Analysis

* Calculate Percent of 3Ms Complete by Individual

A B C D E
Age_Group (All) Y.
Row Labels ~ | Average of Daysl vice ge of 3MsDue Count of A Date Percent of 3Ms Complete
|020ce66b-aeel-481e-b9aa-cc 317 3 1]=ENT( 100*D4/C4) l
0226f76d-3169-421b-b31b-bft 143 1 1 100
02311209-29bd-48cc-a5dd-35¢ 200 2 2 100
023f178d-9e28-4f4c-ac81-bed 114 1 1 100
02417723-2442-470b-a740-4be¢ 1204 13 12 92
02418841-8e95-4be0-8ea8-221 498 5 3 60
025e870c¢-92e0-402d-ab79-65. 236 2 2 100
025ffa36-735d-4058-8959-7f2¢ 1380 15 15 100
028ad70f-f363-4e72-9435-206 442 4 4 100
02984f79-94¢6-4262-bcb6-0be 462 S 3 60
02a8¢9f9-caea-4686-2280-a3fc 377 4 3 75
02be468d-3661-4¢18-b2f0-0c4 1218 13 8 61

7. To calculate the individual percent of 3Ms completed by partner, divide the value in
column D by the value in column C for each partner, multiply by 100 and take the integer.
As seen in this slide, select cell E4 and type the following formula: =INT(100*D4/C4). Select
Enter to exit the cell, and then copy the formula down column E to the end of the dataset.
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' Using Excel for Analysis

» Calculate Percent of 3Ms Complete for All

A [N {nuimber}i) C D E

Age_Group (All) v
Row Labels ~ Average of DaysInService Average of 3MsDue Countof A tDate Percent of 3Ms Complete
ff5c56b4-230b-4416-b226-225 163 1 1 100
ff645f72-7a5e-49de-8c0c-0258 118 1 1 100
ff77e397-e87f-4222-3223-91b° 567 6 2 33
ff7884ca-911c-4d51-bbb6-3b7 3289 36 12 33
ff811de7-0d75-4397-866a-421 279 3 2 66
ff822cc2-1260-4ef7-82d6-5737 237 2 2 100
ff89dd28-5e0e-41d5-9e69-4ft 309 3 3 100
ff8af1b4-47e3-437d-93d8-3a4 604 6 4 66
f916a06-843b-4227-bf1c-a76: 250 2 2 100
ffcbS9ce-ddad-471b-beda-73¢ 342 3 3 100
ffddbaff-9dc3-4604-a0d5-4d5! 345 3 3 100
ffed743c-a991-410c-b677-6ad 203 2 2 100
ffede3c0-1001-4b10-98b8-b2¢ 99 1 1 100
Grand Total 1037.609206 10.85669125 20878

26936] 20878) =INT(100*D4644/Ca644) |

8. To calculate the total percent of 3Ms completed for all partners, sum all of the values in
column D and divide by the sum of values in column C. As seen in this slide, the end of the
data in column C, type the formula =sum(C4:C#), where # is the row number for the last
partner in the pivot table. At the end of the data in column D, type the formula
=sum(D4:D#), where # is the row number for the last partner in the pivot table. In the same
row at column E, type in the formula =int(100*D#/C#), where # where the previous
formulas were entered.
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User Resources

* Getting data in - Users have the following resources:

o FPS DCR Administrator and User Training Curriculum
(completed 3/12/2012)

> FSP DCR Forms
o FSP DCR Data Dictionary (completed 9/15/2011)
FSP DCR User Manual (completed 1/17/2012)

* Getting data out - Users have the following resources:

FPS DCR Data Analysis Training Curriculum (completed
4/20/2012)

FSP DCR User Manual (completed 1/17/2012) — Data Extraction
Instructions

o FSP DCR PLD Templates (completed 1/19/2012)
o FSP DCR Application Notes (completed 4/5/2012)

This FSP DCR Data Analysis Training Curriculum covered the data extraction instructions in
the FSP DCR User Manual (completed 1/17/2012), and the training provided instruction for
utilizing the FSP DCR PLD Templates and User Manual (completed 1/19/2012) to view a
summary of a partner’s data. The training also reviewed the FSP DCR Application Notes
(completed 4/5/2012) which provide instruction for creating specific reports from the DCR
CSV data extraction files.

There are additional resources covering aspects of extracting and analyzing the FSP DCR
data. The FSP DCR Administrator and User Training Curriculum provides an overview of the
FSP DCR Forms, FSP DCR Data Dictionary (completed 9/15/2011) and FSP DCR User Manual
(completed 1/17/2012) . The FSP DCR Administrator and User Training Curriculum is
available for download as a PowerPoint presentation and a handout with presenter’s notes.
Trainers can use this curriculum to provide training internally to new staff using the FSP
DCR.
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This training was funded by the Mental Health

Services Oversight and Accountability Commission
(MHSOAC).
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